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Chapter 1: Overview
This guide documents the ServeRAID C100 and ServeRAID C105 features, and includes instructions for using the 
Human Interface Infrastructure Configuration Utility, the MegaCLI command line utility, and MegaRAID Storage 
Manager™. You can use these utilities to create storage configurations on drives controlled by ServeRAID C105. The 
manual also includes instructions for installing the ServeRAID C100 and ServeRAID C105 drivers in the Microsoft® 
Windows® operating systems and the Linux™ operating system.

1.1 Conventions

The following is a list of notational conventions used throughout this guide. 

Table 1  Conventions

Notation Example Meaning and Use

Courier typeface .nwk file Names of commands, files, and directories are shown in Courier typeface.

Bold typeface fd1sp In a command line, keywords are shown in bold, non-italic typeface. Enter them exactly as 
shown.

Italics module In command lines and names italics indicate user variables. Italicized text must be replaced 
with appropriate user-specified items. Enter items of the type called for, using lowercase.

Italic underscore full_pathname When an underscore appears in an italicized string, enter a user-supplied item of the type 
called for with no spaces.

Initial capital 
letters

Undo
Edit
Apply

Names of menu commands, options, check buttons, text buttons, options buttons, text 
boxes, list boxes, and so on, are shown in text with initial capital lettering to avoid 
misreading. These elements may appear on your screen in all lowercase.

Brackets [version] You may, but need not, select one item enclosed within brackets. Do not enter the brackets.

Bar les | les.out2 You may select one (but not more than one) item from a list separated by bars. Do not enter 
the bar.

Braces {property | -all} You must select one (but not more than one) item enclosed within braces. Do not enter the 
braces.

Ellipses option... In command formats, elements preceding ellipses may be repeated any number of times. 
Do not enter the ellipses. In menu items, if an ellipsis appears in an item, clicking that item 
brings up a dialog box.

Semicolon and 
other 
punctuation

Use as shown in the text.

NOTE  Notes contain supplementary information that can affect system performance.

CAUTION  Attentions are notifications that an action has the potential to adversely affect equipment 
operation, system performance, or data integrity.
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1.2 ServeRAID C100 and ServeRAID C105 Features

ServeRAID C100 and ServeRAID C105 offer software RAID functionality and provide the ability to create and manage 
storage configurations on drives controlled by ServeRAID C100 and ServeRAID C100. ServeRAID C100 and ServeRAID 
C105 provide a cost-effective way to achieve high transfer rates and reliability.

The following sections list the driver features, BIOS features, disk management features, and UEFI support features for 
ServeRAID C100 and ServeRAID C105. In addition, the following section documents the differences between 
ServeRAID C100 and ServeRAID C105.

1.2.1 Driver Features

The driver for ServeRAID C100 and ServeRAID C105 supports the following features:

 Support for 48-bit Logical Block Addressing (LBA)
 Support for drive roaming
 Support for virtual drives larger than 2 terabytes
 Support for migration path from ServeRAID C100 and ServeRAID C105 to ServeRAID SATA hardware (this feature 

requires support from hardware RAID)
 Support for Patrol Read
 Automatic resumption of rebuilding, Check Consistency, full initialization, and background initialization
 Online mirror rebuilding
 Support for auto rebuild
 Support for SATA 6GB drives

 Check Consistency for RAID 1 and RAID 10
 Global hotspare support

 Soft Bad Block Management (SBBM) support
 Support for up to 8 physical drives and eight virtual drives
 Stripe size of 64 Kbytes only
 Support for Disk Coercion (1Gbyte)
 Hot Plug support (drive insertion and removal) in the Microsoft® Windows® operating system and the Linux™ 

operating system
 Support for random deletion of virtual drives
 Error logging and notification
 Support for Microsoft Windows Server 2008 and Microsoft Windows Server 2008 R2 operating systems
 Support for Red Hat Enterprise Linux (RHEL) and SuSE Linux Enterprise Server (SLES) using kernels 2.6 and above

NOTE  ServeRAID C105 supports only SATA HDDs; it does not support SSD or SAS.

NOTE  ServeRAID C105 supports global hotspares, but it does not support dedicated hotspares.



- 9 -

ServeRAID C105 User’s Guide
July 2013

Chapter 1: Overview
ServeRAID C100 and ServeRAID C105 Features

1.2.2 BIOS Features

The ServeRAID C100 and ServeRAID C105 BIOS support has the following features:

 Support for Interrupt 13 and Enhanced Disk Drive Specification
 Support for Int19h
 Support for BIOS Boot Specification (BBS) (If available in system BIOS, this feature allows the user to select the 

controller from which to boot.)
 Support for power-on self test (POST) 
 Support for Post Memory Management (PMM): Specification v7, July 2010
 Industry-standard EBDA
 POST and run-time BIOS support for device insertion and removal
 Support for Stop On Error during boot-up

The following features are supported by the BIOS:

 Automatic resumption of rebuilding, Check Consistency, and full initialization, and Background Initialization (BGI)

 Global hotspare support
 Soft Bad Block Management (SBBM) support
 Support for RAID levels 0, 1, and 10
 Support for auto rebuild
 Support for up to eight physical drives and eight virtual drives
 Stripe size of 64 Kbytes only
 Support for Disk Coercion, with options None, 128 Mbytes, and 1 Gbyte

1.2.3 HII Configuration Features

The HII Configuration Utility supports the following features:

 Ability to configure controllers, drive groups, and virtual drives in a pre-boot environment
 Ability to perform other configuration tasks in a pre-boot environment
 Ability to select and change the settings for some virtual drive parameters
 Ability to select a virtual drive as boot device (by default, virtual drive 0 is the boot drive)
 Support for RAID levels 0, 1, and 10
 Support for running a consistency check
 Support for running a patrol read
 Ability to set the rates for the BGI, consistency check, and patrol read
 Ability to place drives online or offline

1.2.4 Manageability/Disk Console Features

The following features are available to manage the virtual drives and physical drives in the system:

 Configuration information display (in HII Configuration Utility and MegaRAID Storage Manager)
 Support for RAID levels 0, 1, and 10
 Rebuilding mirror while system is operational

NOTE  The BIOS does not start or resume background initialization. If BGI is already in progress, you 
cannot start Check Consistency.
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 Consistency check while system is operational
 Array management software
 Error logging and notification
 Support for hot device insertion and removal
 Automatic resume of rebuilding on restart
 Support for manual rebuild
 Ability to create up to eight virtual drives per configuration
 Auto-configuration support of newly added drive
 Support for global hotspares
 Support for disk coercion
 Drive group initialization support (fast and normal)
 Virtual drive availability immediately after creation
 Supported stripe size of 64 Kbytes only

1.2.5 UEFI Support

Significant challenges face operating system and platform developers to innovate using the legacy PC-AT BIOS boot 
environment. These challenges include memory constraints, maintenance challenges, and increased complexities 
due to a lack of industry-wide standards. 

To handle these challenges, the Unified Extensible Firmware Interface (UEFI) was developed to do the following:

 Define a clean interface between operating systems and the hardware platform at boot time.
 Support an architecture-independent mechanism for initializing add-in cards.

UEFI provides users with expanded platform support. The UEFI driver, a boot service device driver, handles block IO 
requests and SCSI pass-through commands (SPT), and offers the ability to launch pre-boot management applications 
through a driver configuration protocol (DCP). Also, the UEFI driver supports driver diagnostic protocol, which allows 
administrators to access pre-boot diagnostics.

1.2.6 Differences Between ServeRAID C100 and ServeRAID C105

The following table identifies the differences between ServeRAID C100 and ServeRAID C105.

Table 2  Controller Properties

Property ServeRAID C100 ServeRAID C105

Number of Ports
4 AHCI ports  4 standard SCU ports

 4 SCU ports with Feature-on-Demand 
(FoD) key

Drive Support SATA HDD SATA HDD

Drive Swap Support Simple swap Simple swap and hotswap

Optical Device Support
 Supported
 Needs to be enabled in F1 Setup

 Not supported
 Always enabled

RAID Support Needs to be enabled in F1 Setup Always enabled

RAID Level Support RAID 0, 1, 10 RAID 0, 1, 10

Server Support x3100 M3, x3150 M3 BeNain, WuLing, Kestrel
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1.3 RAID Overview

This section provides a brief overview of the types of RAID configurations that ServeRAID C100 and ServeRAID C105 
support.

The first step in creating a RAID storage configuration is to configure drives in drive groups (also known as arrays). As 
defined for ServeRAID C105, a drive group is a group of one to eight drives that is seen by the host computer system as 
one large disk drive, or virtual drive. Only one RAID level can be assigned to each array.

 A RAID 0 drive group consists of one to eight drives.
 A RAID 1 drive group consists of two drives.
 A RAID 10 drive group consists of four, six, or eight drives.

You can use any of these three strategies when creating RAID drive groups and virtual drives:

 Maximize Fault Tolerance: You can maximize fault tolerance to protect against loss of data by creating a RAID 1 
drive group with mirroring. All data is written to the primary drive in the array and is also written (mirrored) to a 
second drive.

 Maximize Virtual Drive Performance: You can maximize virtual drive performance by creating a RAID 0 array 
with striping. Data is broken into segments and can be simultaneously written to or read from several different 
stripes on several different drives in the array.

RAID 10 arrays combine both striping and mirroring to provide high data transfer rates and data redundancy.

 Maximize Storage Capacity: You can maximize storage capacity when selecting a RAID level. Striping alone 
(RAID 0) requires less storage space than mirrored data (RAID 1). 

1.3.1 RAID 0 Description

RAID 0 provides disk striping across all drives in the drive group. RAID 0 does not provide any data redundancy, but 
does offer the best performance of any RAID level. RAID 0 breaks up data into smaller segments called strips, and then 
stripes the data segments across each drive in the array. The size of each data segment is determined by the strip size, 
which is 64 Kbytes.

By breaking up a large file into smaller segments, and writing or reading from several drives at once, ServeRAID C105 
can read or write the file faster. This feature makes RAID 0 ideal for applications that require high bandwidth but do 
not require fault tolerance.

NOTE  Some hardware configurations do not support eight drives. Depending on the hardware, the 
actual maximum number of drives for RAID 0 and RAID 10 arrays might be fewer than eight.

NOTE  It is possible to create each disk as a single-drive RAID 0 drive group. However, spanning across single 
drive RAID 0 arrays is not supported.

Uses Provides high data throughput, especially for large files; any environment that does not require fault tolerance

Strong Points Provides increased data throughput for large files; no capacity loss penalty for parity

Weak Points Does not provide fault tolerance; all data lost if any drive fails

Drives One to eight
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The following figure shows a RAID 0 array with two drives.

Figure 1  RAID 0 Array Example with Two Drives

1.3.2 RAID 1 Description

RAID 1 duplicates all data from one drive to a second drive. RAID 1 provides complete data redundancy, but at the cost 
of doubling the required data storage capacity.

The following figure shows a RAID 1 drive group.

Figure 2  RAID 1 Array

1.3.3 RAID 10 Description

RAID 10, a combination of RAID 1 and RAID 0, has mirrored drives. It breaks up data into smaller blocks, and then 
stripes the blocks of data to each RAID 1 RAID set. Each RAID 1 RAID set then duplicates its data to its other drive. The 
size of each block is determined by the strip size parameter, which is 64 Kbytes. RAID 10 can sustain one drive failure in 
each drive group while maintaining data integrity. 

Uses Databases or any other mission critical environment that requires fault tolerance

Strong Points Provides complete data redundancy; RAID 1 is ideal for any application that requires fault tolerance

Weak Points Requires twice as many drives; performance is impaired during drive rebuilds

Drives Two

NOTE  On a RAID 10 array, you can create only one virtual drive, and that virtual drive must occupy the entire 
space of the RAID 10 array.

Segment 1

Segment 3
Segment 5

Segment 2

Segment 4
Segment 6

Segment 7 Segment 8

Segment 1
Segment 2
Segment 3

Segment 1 Duplicated
Segment 2 Duplicated
Segment 3 Duplicated

Segment 4 Segment 4 Duplicated
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The following figure shows a RAID 10 array with four drives.

Figure 3  RAID 10 Array

Uses

Works best for data storage that must have 100% redundancy of RAID 1 (mirrored drive groups) and that also 
needs the enhanced I/O performance of RAID 0 (striped drive groups); RAID 10 works well for medium-sized 
databases or any environment that requires a higher degree of fault tolerance and moderate to medium 
capacity

Strong Points Provides both high data transfer rates and complete data redundancy

Weak Points Requires twice as many drives

Drives Four, six, or eight

RAID 1

Disk 2Disk 1 Disk 4Disk 3

RAID 1

RAID 0

Segment 1
Segment 3
Segment 5

Segment 1
Segment 3
Segment 5

Segment 2
Segment 4
Segment 6

Segment 2
Segment 4
Segment 6

Segment 2
Segment 4
Segment 6
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Chapter 2: Driver Installation

Device drivers for the ServeRAID C100 and ServeRAID C105 can be obtained from the Support & downloads section 
of the IBM web site (http://www.ibm.com). Usage instructions and step-by-step installation instructions for your 
specific device driver are available in the README file that accompanies that driver on the download site.

http://www.ibm.com
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Chapter 3:  Human Interface Infrastructure Configuration Utility

The Human Interface Infrastructure (HII) Configuration Utility (CU) is used to configure controllers, drive groups, and 
virtual drives, and to perform other configuration tasks in a pre-boot environment. 

This chapter describes how to configure controllers, drive groups, and virtual drives with the HII Configuration Utility. 
To ensure the best performance, select the optimal RAID level for the virtual drive you create. For an explanation of 
RAID levels, see Section 1.3, RAID Overview.

3.1 Accessing the Configuration Options Screen

You can use the Configuration Options screen to manage the controller, virtual drives, and physical drives. 

Perform the following steps to access the Configuration Options screen. 

1. Boot the system.

2. Press F1 during bootup to enter setup.

The System Configuration and Boot Management screen appears, as shown in the following figure.

Figure 4  System Configuration and Boot Management Screen
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3. Highlight System Settings and press Enter.

The System Settings screen appears, as shown in the following figure.

Figure 5  System Settings Screen

4. Highlight Devices and I/O Ports and press Enter.

The Devices and I/O Ports screen appears.

5. Verify that the Configure SATA as field is set to RAID on the Devices and I/O Ports screen.

6. If this field is set to RAID, press Esc to return to the System Settings screen.

If this field is not set to RAID, perform the following steps:

a. Highlight the Configure SATA as options and press Enter.

IDE, AHCI, and RAID appear as the options.

b. Highlight RAID and press Enter.
c. Press Esc until you return to the System Configuration and Boot Management screen.
d. Highlight Save Settings and press Enter.
e. Reboot your system.
f. Press F1 during bootup to enter setup.

The System Configuration and Boot Management screen appears, as shown in the following figure.

g. Highlight System Settings and press Enter.

The System Settings screen appears. The Storage menu option is now available on this screen.
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7. Highlight Storage on the System Settings screen and press Enter.

The Storage screen appears, as shown in the following figure.

Figure 6  Storage Screen

8. Highlight your controller and press Enter.

The Configuration Options screen appears, as shown in the following figure. This screen lists the following 
management options:

— Controller Management: Select this option to view and/or change the controller properties, save 
configurations, and perform other tasks. You can view information about the controller and the devices 
connected to it. For more information, see Section 3.2, Managing Controllers.

— Virtual Drive Management: Select this option to access the Virtual Drive Management screen, where you 
can create virtual drive configurations, change the virtual drive name, delete virtual drives, initialize drives, 
and perform other tasks. For more information, see Section 3.3, Managing Virtual Drives.

— Drive Management: Select this option to access the Drive Management screen, where you can view drive 
properties and perform tasks. For more information, see Section 3.4, Managing Drives.
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Figure 7  Configuration Options Screen

3.2 Managing Controllers

This section explains how you can use the HII configuration utility to view and change the properties for controllers, 
and clear a configuration.
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3.2.1 Viewing Controller Properties

The HII configuration utility displays information for one controller at a time.

Perform the following steps to view the controller properties.

1. Highlight Controller Management on the Configuration Options screen (Figure 7), and press Enter. 

The Controller Management screen appears, as shown in the following figure.

Figure 8  Controller Management Screen
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2. Highlight View Controller Information and press Enter.

The Controller Management >> View Controller Information screen appears, as shown in the following figure.

Figure 9  Controller Management >> View Controller Information Screen

The information on this screen is read-only; it cannot be modified directly. Most of this information is 
self-explanatory, such as the number of virtual drives that are defined on this controller, and the number of drives 
connected to the controller.

The following table defines the controller properties.

Table 3  Controller Properties

Property Description

Controller Marketing Name ServeRAID C105

Serial Number Indicates the manufacturer-assigned serial number.

PCI ID The ID number for the Peripheral Component Interconnect local bus.

Host Interface Indicates the type of interface used by the computer host system, such as PCI-E.

Host Port Count Indicates the maximum number of ports supported by the software RAID controller in which 
devices (such as CD-ROM and disks) can be connected.

PCI Slot Number N/A for software RAID

Drive Count The number of drives connected to the selected controller.

Virtual Drive Count The number of virtual drives supported by the selected controller.
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3.2.2 Changing Controller Properties

You can use the HII configuration utility to change the properties for a controller. Perform the following steps to 
change information for a controller.

1. Highlight Controller Management on the Configuration Options screen (Figure 7) and press Enter. 

The Controller Management screen appears, as shown in the following figure.

Figure 10  Controller Management Screen

Encryption Capable N/A for software RAID

Minimum Stripe Size 64 KB is the only stripe size available.

Maximum Stripe Size 64 KB is the only stripe size available.

Driver Version The version of the device driver.

Table 3  Controller Properties

Property Description
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2. Highlight Change Controller Properties and press Enter.

The Controller Management >> Change Controller Properties screen appears, as shown in the following figure.

Figure 11  Controller Management >> Change Controller Properties Screen

3. Change the following controller properties as desired.

a. Set Factory Defaults: Use the arrow keys to move the cursor to this property and press Enter. On the 
Confirm screen, select Yes to confirm your selection.

b. Rebuild Rate: Use the arrow keys to move the cursor to this property. Press the plus (+) key to increase the 
rate or the minus (-) key to decrease the rate.

c. Background Initialization (BGI) Rate: Use the arrow keys to move the cursor to this property. Press the 
plus (+) key to increase the rate or the minus (-) key to decrease the rate.

d. Consistency Check Rate: Use the arrow keys to move the cursor to this property. Press the plus (+) key to 
increase the rate or the minus (-) key to decrease the rate.

e. Disk Coercion: Use the arrow keys to move the cursor to this property. Press the plus key (+) to set the value
f. to 128 MB, 1 GB or None.
g. Read Ahead: Use the arrow keys to Enable or Disable.
h. Disk WC: Use the arrow keys to Enable or Disable.
i. Auto Rebuild: Use the arrow keys to Enable or Disable.
j. Auto Resume: Use the arrow keys to Enable or Disable.
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The following table defines these controller properties.

4. Highlight Apply Changes and press Enter to register your changes.

Your changes are registered and the controller properties are changed. 

3.2.3 Clearing Configurations

Perform the following steps to clear all of the existing configurations on the controller.

1. Highlight Controller Management on the Configuration Options screen (Figure 7) and press Enter. 

2. Highlight Clear Configuration on the Controller Management screen (Figure 8) and press Enter.

3. Highlight Yes to confirm your selection on the Confirm screen.

This action clears the existing configurations.

Table 4  Changing Controller Properties

Property Description

Set Factory Defaults Resets factory default values for all of the controller properties.

Set Boot Devices Selects the virtual drive to use as the boot device.

Rebuild Rate The percentage of central processing unit (CPU) resources devoted to rebuilding data onto a 
new drive after a drive in a storage configuration has failed. The default value is 30 percent.

Background Initialization (BGI) 
Rate

Background initialization is a check for media errors on the drives when you create a virtual 
drive. It is an automatic operation that starts five minutes after you create the virtual drive. This 
check ensures that striped data segments are the same on all of the drives in the drive group. 
The default value is 30 percent.

Consistency Check Rate A consistency check is an operation that verifies that all stripes in a virtual drive with a 
redundant RAID level are consistent and that automatically fixes any errors. The consistency 
check rate is the rate at which consistency check operations are run on a computer system. The 
default value is 30 percent.

Disk Coercion Drive coercion is a tool for forcing drives of varying capacities to the same capacity so they can 
be used in a drive group. The coercion mode options are None, 128MB-way, and 1GB-way. The 
number you choose depends on how much the drives from various vendors vary in their actual 
size. 

Read Ahead When disk Read Ahead is enabled, extra data is read sequentially ahead of the data that is 
actually requested, and this extra data is stored in cache memory. If the additional read-ahead 
data is then requested, it can be read faster from the cache than from the disk directly. This 
setting speeds up reads for sequential data, but there is little improvement when accessing 
random data. 

Disk WC You can disable the disk write cache option when you create a virtual drive, but you can enable 
this option later using the configuration utilities. When the disk Write Cache is enabled, a write 
transaction is considered to be complete when all the data has been written to the disk cache. 
When disk Write Cache is disabled, the write transaction is complete only when the data has 
been written to the disk. 

Auto Rebuild Auto-rebuild allows a failed drive to be replaced and the data automatically rebuilt by 
hot-swapping the drive in the same drive bay. The RAID drive group continues to handle 
requests while the rebuild occurs. 

Auto Resume When Enabled, you can stop a consistency check, rebuild, or initialization, and resume it later 
where it left off, instead of aborting it and starting over. 
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3.3 Managing Virtual Drives

You can use the Virtual Drive Management screen to create virtual drive configurations, view and change the virtual 
drive properties, delete virtual drives, initialize drives, and perform other tasks related to the virtual drives.

3.3.1 Configuring Virtual Drives

This section provides detailed instructions for configuring drive groups and virtual drives with the HII configuration 
utility. 

It is recommended that you use drives with the same capacity when you create a storage configuration. If you use 
drives with different capacities in one array, the configuration utility limits each drive to the capacity of the smallest 
drive.

The number of physical drives in a specific array determines the possible RAID levels that you can implement with the 
array. 

 RAID 0 requires from one to eight physical drives.
 RAID 1 requires two physical drives.
 RAID 5 required three to eight physical drives.
 RAID 10 requires four, six, or eight physical drives.

NOTE  The stripe size is read-only. You cannot change the settings for this property.
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Follow these steps to access the Virtual Drive Management screen and create a virtual drive configuration.

1. Highlight Virtual Drive Management on the Configuration Options screen (Figure 7) and press Enter. 

The Virtual Drive Management screen appears, as shown in the following figure.

Figure 12  Virtual Drive Management Screen
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2. Highlight Create Configuration and press Enter.

The Virtual Drive Management >> Create Configuration screen appears, as shown in the following figure. The 
default settings display in the fields.

Figure 13  Virtual Drive Management >> Create Configuration Screen

3. Use the arrow keys to select any highlighted fields (one at a time) that you want to change the setting for and 
press Enter. 

4. Select the setting for each property that you want to change from the default.

You can change the settings for the following fields on this screen:

— Select RAID Level: The menu lists the possible RAID levels for the virtual drive. See Section 1.3, RAID 
Overview, for more information about RAID levels.

— Select Drives From: The menu lists the sources that you can use to select drives for the virtual drive. The 
options are Unconfigured Capacity and Free Capacity.

— Select Drives: Press this button and a screen appears that lists the Unconfigured Good drives or the free 
capacity, depending on the value you selected in the Select Drive From field.

— Virtual Drive Name: Enter the name of the virtual drive.
— Virtual Drive Size: Enter the capacity of the virtual drive. Normally, this value is the full capacity of the drives 

in the virtual drive. 
— Virtual Drive Size Unit: Enter the unit of capacity you want to use for the virtual drive. The options are MB, 

GB, and TB.
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— Read Ahead – When disk Read Ahead is enabled, extra data is read sequentially ahead of the data that is 
actually requested, and this extra data is stored in cache memory. If the additional read-ahead data is then 
requested, it can be read faster from the cache than from the disk directly. This setting speeds up reads for 
sequential data, but there is little improvement when accessing random data. 

— Disk WC – You can disable the disk write cache option when you create a virtual drive, but you can enable 
this option later using the configuration utilities. When the disk Write Cache is enabled, a write transaction is 
considered to be complete when all the data has been written to the disk cache. When disk Write Cache is 
disabled, the write transaction is complete only when the data has been written to the disk. 

— Disable Background: Use this option to select the amount of system resources dedicated to background 
initialization of virtual drives connected to the selected controller.

The following setting is read-only and cannot be changed.
— Stripe Size: A stripe consists of the data segments that the RAID controller writes across multiple drives, not 

including parity drives. The default is 64 KB.

3.3.2 Managing Virtual Drive Properties

After you create a virtual drive, you can use the Virtual Drive Management screen to change the name of the virtual 
drive. 

NOTE  You can change only the virtual drive name for the virtual drive that is selected. The other virtual drive 
properties are read-only.
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Perform the following steps to access the virtual drive properties screen and change the name of the virtual drive.

1. Highlight Virtual Drive Management on the Configuration Options screen (Figure 7) and press Enter. 

The Virtual Drive Management screen appears, as shown in the following figure.

Figure 14  Virtual Drive Management Screen
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2. Highlight Manage Virtual Drive Properties and press Enter.

The Virtual Drive Management >> Manage Virtual Drive Properties screen appears, as shown in the following 
figure.

Figure 15  Virtual Drive Management >> Manage Virtual Drive Properties Screen

3. Highlight the Virtual Drive Name field and press Enter.

4. Enter a different name for the virtual drive and press Enter.

5. Highlight Apply Changes and press Enter to make the selected change.

The name of the virtual drive is changed.

3.3.2.1 Viewing Associated Drives 

Perform the following steps to view associated drives for a virtual drive properties:

1. Highlight the View Associated Drives in the Manage Virtual Drive Properties menu and Press Enter.

The drives associated with the current virtual drive appears, as shown in the following figure.
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Figure 16  Associated Drives for a Virtual Drive

2. Highlight View Drive Properties and Press Enter.

The Drive properties page for the physical drive appears.
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3.3.3 Selecting Virtual Drive Operations

You can use the Virtual Drive Management screen to select and launch operations related to the virtual drive 
properties. 

Perform the following steps to access the virtual drive operations screen and carry out operations for the virtual drive 
properties.

1. Highlight Virtual Drive Management on the Configuration Options screen (Figure 7) and press Enter. 

The Virtual Drive Management screen appears, as shown in the following figure.

Figure 17  Virtual Drive Management Screen
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2. Highlight Select Virtual Drive Operations and press Enter.

The Virtual Drive Management >> Select Virtual Drive Operations screen appears, as shown in the following 
figures.

Figure 18  Select Virtual Drive Operations Screen

3. Highlight each operation you want to carry out and press Enter. 

The options for the virtual drive operations appear. Here are brief explanations of the virtual drive operations:

— Select Virtual Drive: Select the virtual drive you want to carry out operations on. The screen displays the 
virtual drive number, virtual drive name, RAID level, virtual drive capacity, and virtual drive status.

— Start Locate: Flash the LEDs on all the drives associated with the virtual drive.
— Stop Locate: Stop flashing the LEDs on the drives associated to the virtual drive.
— Virtual Drive Operation: Select Fast Initialization or Slow Initialization to initialize this virtual drive. A fast 

initialization quickly writes zeroes to the first and last 10-MB regions of the new virtual drive and then 
completes the initialization in the background. A slow initialization is not complete until the entire virtual 
drive has been initialized with zeroes. It is seldom necessary to use this option, because the virtual drive was 
initialized right after you created it. 

NOTE  If you have redundant virtual drives (i.e., virtual drives that use RAID 1, 5, or 10), you have the 
option to perform the Check Consistency operation. The consistency check operation corrects 
inconsistencies between a protected volume and its replica.
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4. Highlight Start Operation and press Enter. 

The confirmation screen appears.

5. Highlight Yes and press Enter to confirm that you want to carry out the operations.

3.3.4 Viewing Drive Group Properties

You can use the Virtual Drive Management screen to access the drive group properties screen and view the properties. 
The drive group contains the drives that are used to create the virtual drive.

Perform the following steps to access the drive group properties screen and view the drive group properties.

1. Highlight Virtual Drive Management on the Configuration Options screen (Figure 7) and press Enter. 

The Virtual Drive Management screen appears, as shown in the following figure.

Figure 19  Virtual Drive Management Screen

NOTE  The Start Operation option and the Stop Operation option toggle based on the current status of 
the operation. For example, after you start an operation, the Start Operation field is no longer highlighted, 
and the Stop Operation field is highlighted.

NOTE  After you choose an operation and select Start Operation, the progress bar appears, showing zero 
percent. To see the change in the percentage of progress, return to the previous page and then access 
this page again.
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2. Highlight View Drive Group Properties and press Enter.

The Virtual Drive Management >> View Drive Group Properties screen appears, as shown in the following figure.

Figure 20  View Drive Group Properties Screen

The screen displays the drive group number, drive group name, RAID level, virtual drive capacity, and virtual drive 
status.
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3. Highlight the drive group and press Enter.

The drive group properties and any free capacity appear in the list, as shown in the following figure.

Figure 21  Drive Group Properties and Free Space

3.4 Managing Drives

You can use the Drive Management screen to view and change the physical drive properties of the drives in a drive 
group.
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3.4.1 Viewing Drive Properties

Perform the following steps to access the drive properties screen and view the values for the properties.

1. Highlight Drive Management on the Configuration Options screen (Figure 7) and press Enter. 

The Drive Management screen appears, as shown in Figure 22.

Figure 22  Drive Management Screen
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2. Highlight View Drive Properties and press Enter.

The Drive Management >> View Drive Properties screen appears, as shown in the following figures.

Figure 23  Drive Management >> View Drive Properties Screen

NOTE  The following two figures show the drive properties. Scroll down on Figure 24 to see the additional 
properties on the View Drive Properties screen.
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Figure 24  Drive Management >> View Drive Properties Screen (Continued)

You can highlight the Associated Virtual Drive field and press Enter to view the properties. However, you cannot 
change the values in this field. 

Here are brief explanations of the drive properties and their values:

— Select Drive: The drive number, drive slot, drive type, drive capacity, and drive status of the selected drive.
— Drive ID: Indicates the ID and drive slot of the selected drive.
— State: Indicates the state of the selected drive, such as Online, Offline, or Unconfigured Good.
— Coerced Size (MB): Indicates the capacity to which the selected drive has been coerced to make it 

compatible with other drives that are nominally the same capacity.
— Device Type: Indicates the type of device selected, such as a drive, tape, or CD/DVD-ROM.
— Connected Port: Indicates the port that the selected drive is connected to.
— Media Errors: Indicates the number of media errors on the drive. Media errors are physical defects on the 

drive.
— Predicted Fail Count: Indicates the predicted number of drive failures.
— Available Size (MB): Indicates the free capacity of the selected drive.
— Used Space (MB): Indicates the configured space of the selected drive in MB.
— Disk Protocol: Indicates the type of drive selected, such as SATA.
— Negotiated Drive Transfer Speed: Indicates the negotiated link speed for the data transfer to or from the 

selected drive.
— Number of Connections: Indicates the number of devices connected.
— Associated Virtual Drive: Indicates the virtual drive number, virtual drive name, RAID level, virtual drive 

capacity, and virtual drive status.
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3.4.2 Selecting Drive Operations

Perform the following steps to access the drive operations screen and carry out the operations.

1. Highlight Drive Management on the Configuration Options screen (Figure 7) and press Enter. 

The Drive Management >> Select screen appears, as shown in the following figure.

Figure 25  Drive Management Screen
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2. Highlight Select Drive Operations and press Enter.

The Drive Management >> Select Drive Operations screen appears, as shown in the following figure.

Figure 26  Drive Management >> Select Drive Operations Screen

3. Highlight an operation and press Enter.

The following items describe the drive operations:

— Select Drive: Select the drive you want to carry out operations on. The screen displays the drive number, slot 
number, drive type, drive capacity, and drive status.

— Start Locate: Flash the LED on the selected drive.
— Stop Locate: Stop flashing the LED on the selected drive.
— Drive Operation: Make a drive offline or online. The options are Place Drive Offline and Place Drive Online.

4. Highlight Start Operation and press Enter.

The confirmation screen appears.

5. Highlight Yes and press Enter.

The controller performs the selected operations.

NOTE  If a good drive is part of a redundant drive group that includes a hotspare, and you force the 
drive offline, the data on the drive is rebuilt on the hotspare drive. The good drive that you forced 
offline goes into the Unconfigured Bad state.
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3.4.3 Viewing Global Hotspare Drives

Highlight View Global Hot Spare and press Enter to display all the assigned global hot spare on the RAID controller. 
A hot spare disk is a disk that replaces a failing or failed disk in a RAID configuration. The replacement is automatic or 
manually, depending in the hot spare policy,
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Chapter 4: MegaCLI Command Line Interface

The MegaCLI utility is a command line interface application that you can use to configure and maintain storage 
configurations created with ServeRAID C100 and ServeRAID C105.

4.1 MegaCLI Overview

You can use the MegaCLI utility to perform the following tasks: 

 Configure virtual drives and create configurations on the controller
 Display the configuration on the controller
 Display and change virtual drive’s properties on the controller
 Display and change physical drive’s properties on the controller
 Display and change controller properties
 Load a configuration to the controller from a file
 Save an controller configuration to a file
 Start or stop rebuild, consistency check, and initialization
 Suspend and display an ongoing background initialization
 Display relevant user messages on the console or write them to the log file
 Work in silent mode, if selected (no messages are displayed on the console)
 Display controller inventory data in a single command
 Customize output strings
 Exit with predefined success or failure exit codes
 Set some predefined environment variables, such as number of controllers and the number of virtual drives
 Display help on how to use the command line options

4.2 Exception Handling

MegaCLI exits with exit code 0 for all successful operations. In case of failure, it exits with exit code 1 to 255, 
depending on the failure conditions. For example, assume that a rebuild is started on three physical drives. MegaCLI 
successfully starts rebuilding the first drive but fails to start rebuilding the second drive. If this happens, MegaCLI does 
not attempt to start rebuilding the third drive; instead, it exits with an error exit code. In this case, the error code is 
EXIT_ERR_START_RBLD. So even if the command was partially successful, an error code is still generated.

Some operations such as GetNumberOfAdapters or GetNumberofLogicaldrives return with the actual 
number of controllers or virtual disks. These return values are special cases and do not reflect any error conditions 
based on the return code, which in these cases contains meaningful values.

NOTE  The MegaCLI utility runs in the Microsoft® Windows® operating system environment and the Linux® 
operating system environment.

NOTE  The MegaCLI utility supports IBM ServeRAID products. However, some of the commands might not be 
supported by ServeRAID C100 and ServeRAID C105.
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4.3 Command Line Abbreviations and Conventions

This section explains the abbreviations and conventions used with MegaCLI Configuration Utility commands.

4.3.1 Abbreviations Used in the Command Line

Table 5 lists the abbreviations for the virtual drive parameters used in the following sections.

4.3.2 Conventions

You can specify multiple values for some options. You can enter commands for a single controller (-aN), multiple 
selected controllers (-a0,1,2) or all controllers (-aALL). This usage is denoted as -aN| -a0,1,2|-aALL in the 
command line syntax used in this chapter. Table 6 lists all of the conventions used in the command line options.

Table 5  Command Line Abbreviations

Convention Description

WB WriteBack write policy

WT WriteThrough write policy

ADRA Adaptive Read Ahead read policy

RA Read Ahead read policy

NORA Normal Read policy (No read ahead)

DIO Direct I/O cache policy

CIO Cached I/O cache policy

NOTE  All options in the MegaRAID Command Tool are position-dependent, unless otherwise specified.

Table 6  Conventions

Convention Description

MegaCLI Specifies the command line interface used. Type either MegaCLI under Microsoft Windows and 
Linux

| Specifies “or,” meaning you can choose between options.

-aN N specifies the controller number for the command.

-a0,1,2 Specifies the command is for controllers 0, 1, and 2. You can select two or more controllers in this 
manner.

-aALL Specifies the command is for all controllers.

-Lx x specifies the virtual drive number for the command.

-L0,1,2 Specifies the command is for virtual drives 0, 1, and 2. You can select two or more virtual drives in this 
manner.

-Lall Specifies the command is for all virtual drives.

[E0:S0,E1,S1,…] Specifies when one or more physical devices need(s) to be specified in the command line. Each 
[E:S] pair specifies one physical device where E means the device ID of the enclosure in which a 
drive resides, and S means the slot number of the enclosure.
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You can specify the -Silent command line option for all possible functions of the MegaCLI. If you enter this option 
at the command line, no messages appear on the screen.

The following MegaCLI CT commands that are supported in hardware RAID configurations are not supported by 
ServeRAID C105:

 Adapter Cache Flush (-AdpCacheFlush)
 Cluster Enable is not supported
 Foreign Configuration (-CfgForeign)
 Virtual Drive Reconstruction (-LDRecon)
 Set Virtual Drive Properties (-LDSetProp)
 Display Enclosure Information (-EncInfo)
 Mark Configured Physical Disk Drive as Missing (-PDMarkMissing)
 Display List of Missing Physical Disk Drives (-PDGetMissing)
 Diagnostics (-AdpDiag, -AdpBatTest, -AdpNVRAM)

The following sections describe the MegaCLI commands.

[ ] Indicates that the parameter is optional.

{ } Indicates that the parameters are grouped and that they must be given at the same time.

-Force Specifies that the MegaCLI utility does not ask you for confirmation before it performs this 
command. You might lose data using this option with some commands.

NOTE  ServeRAID C105 does not support Write Policy, Read Policy, or I/O Policy. ServeRAID C105 supports only 
enabling and disabling the drive’s write cache and read-ahead functions.

NOTE  MegaCLI for ServeRAID C105 does not support the concept of disk enclosures, except for a default 
Enclosure 0 (E0). Some of the commands support an E0:Sn syntax that enables you to specify a drive in a 
particular “slot” in this default enclosure.

Table 6  Conventions (Continued)

Convention Description
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4.4 Controller Commands

You can use the commands in this section to set or display properties related to the controller(s).

4.4.1 Display Controller Information

Use the command in Table 7 to display information on controller parameters such as the number of virtual drives and 
initiator ID.

4.4.2 Enable or Disable Automatic Rebuild

Use the command in Table 8 to turn automatic rebuild on or off for the selected controller(s). If you have configured 
hotspares and enabled automatic rebuild, the RAID controller automatically tries to use them to rebuild failed disks. 
Automatic rebuild also controls whether a rebuild will start when a drive that was part of the array is reinserted.

4.4.3 Set Controller Properties

This command sets the properties on the selected controller(s). For example, for {RebuildRate -val}, you can 
enter a value between 0 percent and 100 percent. (The rebuild rate is the percentage of the compute cycles dedicated 
to rebuilding failed drives.) At 0 percent, the rebuild is done only if the system is not doing anything else. At 
100 percent, the rebuild has a higher priority than any other system activity. 

NOTE  The drivers for ServeRAID C105 function as virtual “adapters” or “controllers.” Because the drivers are 
not actual hardware components, some of the controller parameters do not apply to them.

Table 7  Display Controller Information

Syntax MegaCLI –AdpAllInfo -aN|-a0,1,2|-aALL

Description
Displays parameters on the selected controller(s). The parameters includes initiator ID, current status of auto 
rebuild, number of virtual drives, rebuild rate, bus number/device number, present RAM, settings, and serial 
number of the board.

Table 8  Enable or Disable Automatic Rebuild

Syntax MegaCLI –AdpAutoRbld -Enbl|-Dsbl|-Dsply -aN|-a0,1,2|-aALL

Description
Enables or disables automatic rebuild on the selected controller(s).
The -Dsply option shows the status of the automatic rebuild state.

NOTE  The default rebuild rate of 30 percent is recommended.
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Use the command in Table 9 to display or set controller properties.

Table 9  Set Controller Properties

Syntax

MegaCLI –AdpSetProp {CacheFlushInterval –val}|{RebuildRate -val}| 
{PatrolReadRate –val}|{BgiRate –val}|{CCRate –val}| {ReconRate –val}| 
{SpinupDriveCount –val}|{SpinupDelay –val}|{CoercionMode –val} | 
{ClusterEnable –val}|{PredFailPollInterval –val}| {BatWarnDsbl –val}| 
{EccBucketSize –val}|{EccBucketLeakRate –val}|{AbortCCOnError 
–val}|AlarmEnbl | AlarmDsbl | AlarmSilence |{SMARTCpyBkEnbl –val} | 
-AutoDetectBackPlaneDsbl | -CopyBackDsbl | -LoadBalanceMode 

| NCQEnbl | NCQDsbl | {SSDSMARTCpyBkEnbl -val} | {MaintainPdFailHistoryEnbl 
-val} | {EnblSpinDownUnConfigDrvs -val} | {EnblSSDPatrolRead -val} | 
AutoEnhancedImportEnbl | AutoEnhancedImportDsbl | {-UseFDEOnlyEncrypt -val} 
| {-PrCorrectUncfgdAreas -val} | -aN| -a0,1,2|-aALL

Description

Sets the properties on the selected controller(s). The possible settings are:
CacheFlushInterval: Cache flush interval in seconds. Values: 0 to 255.
RebuildRate: Rebuild rate. Values: 0 to 100.
PatrolReadRate: Patrol read rate. Values: 0 to 100.
BgiRate: Background initilization rate. Values: 0 to 100.
CCRate: Consistency check rate. Values: 0 to 100.
ReconRate: Reconstruction rate. Values: 0 to 100.
SpinupDriveCount: Max number of drives to spin up at one time. Values: 0 to 8.
SpinupDelay: Number of seconds to delay among spinup groups. Values: 0 to 8.
CoercionMode: Drive capacity Coercion mode. Values: 0 - None, 1 - 128 MB, 2 - 1 GB.
The coercion type can be set only when there is no configuration present on the controller.
ClusterEnable: Cluster is enabled or disabled. Values: 0 - Disabled, 1 - Enabled.
PredFailPollInterval: Number of seconds between predicted fail polls. Values: 0 to 65535.
BatWarnDsbl: Disable warnings for missing battery or missing hardware. Values: 0 - Enabled, 1 - Disabled.
EccBucketSize: Size of ECC single-bit-error bucket. Values: 0 to 255.
EccBucketLeakRate: Leak rate (in minutes) of ECC single-bit-error bucket. Values: 0 to 65535.
AbortCCOnError: 
AlarmEnbl: Set alarm to Enabled.
AlarmDsbl: Set alarm to Disabled.
AlarmSilence: Silence an active alarm.
SMARTCpyBkEnbl: Enable copyback operation on Self-Monitoring Analysis and Reporting Technology 
(SMART) errors. Copyback is initiated when the first SMART error occurs on a drive that is part of a virtual drive.
AutoDetectBackPlaneDsbl: Detect automatically if the backplane has been disabled.
CopyBackDsbl: Disable or enable the copyback operation.
LoadBalanceMode: Disable or enable the load balancing mode.
NCQEnbl: Enable the native command queueing.
NCQDsbl: Disable the native command queueing.
SSDSMARTCpyBkEnbl: Enable copyback operation on Self-Monitoring Analysis and Reporting Technology 
(SMART) errors on a Solid State Drive (SSD). Copyback is initiated when the first SMART error occurs on a SSD 
that is part of a virtual drive.
MaintainPdFailHistoryEnbl: Enable maintenance of the history of a failed drive.
EnblSpinDownUnConfigDrvs: Enable spindown of unconfigured drives.
EnblSSDPatrolRead: Enable the patrol read operation (media scan) on a SSD.
AutoEnhancedImportEnbl: Enable the automatic enhanced import of foreign drives.
AutoEnhancedImportDsbl: Disable the automatic enhanced import of foreign drives.
UseFDEOnlyEncrypt: Use encryption on FDE drives only.
PrCorrectUncfgdAreas: Ignores all patrol read errors by writing 0s.
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4.4.4 Display Specified Controller Properties

Use the command in Table 10 to display specified properties on the selected controller(s).

4.4.5 Display Controller Time

Use the command in Table 11 to display the current time and date of the selected controller.

4.4.6 Set Factory Defaults

Use the command in Table 12 to set the factory defaults on the selected controller(s).

Table 10  Display Specified Controller Properties

Syntax

MegaCLI –AdpGetProp CacheFlushInterval | RebuildRate | PatrolReadRate| 
BgiRate | CCRate | ReconRate | SpinupDriveCount | SpinupDelay | CoercionMode 
| PredFailPollInterval | ClusterEnable | BatWarnDsbl | EccBucketSize | 
EccBucketLeakRate | EccBucketCount | AlarmDsply | AbortCCOnError |  
AutoDetectBackPlaneDsbl | CopyBackDsbl | LoadBalanceMode | SMARTCpyBkEnbl | 
SSDSMARTCpyBkEnbl | MaintainPdFailHistoryEnbl | EnblSpinDownUnConfigDrvs | 
EnblSSDPatrolRead |  NCQDsply | UseFDEOnlyEncrypt | WBSupport | 
AutoEnhancedImportDsbl | PrCorrectUncfgdAreas | DsblSpinDownUnConfigDrvs | 
-aN|-a0,1,2|-aALL

Description

Displays the properties on the selected controller(s). 
EccBucketCount: Count of single-bit ECC errors currently in the bucket.
WBSupport: Enables support for the WriteBack option as the Write Policy.
DsblSpinDownUnConfigDrvs: Disable spindown of unconfigured drives.
See Table 9 for explanations of the other options.

Table 11  Display Controller Time

Syntax MegaCLI –AdpGetTime -aN

Description Displays the time and date on the controller. This command uses a 24-hour format. For example, 7 p.m. would 
display as 19:00:00.

Table 12  Set Factory Defaults

Syntax MegaCLI -AdpFacDefSet -aN|-a0,1,2|-aALL

Description Sets the factory defaults on the selected controller(s). You cannot set the factory defaults if the controller 
already has a configuration defined on it.
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4.5 Event Log Commands

4.5.1 Manage the Event Log Entries

Use the command in Table 13 to manage the event entries in the event log for the selected controller(s).

Table 13  Event Log Management

Syntax
MegaCLI –AdpEventLog –GetEventlogInfo |{–GetEvents | GetSinceShutdown| 
GetSinceReboot | IncludeDeleted | {GetLatest <number>} –f <filename>} |Clear 
-aN|-a0,1,2|-aALL 

Description

The RAID driver maintains a volatile circular list of 100 events, which is deleted at reboot. The following 
command options are available:
 -GetEventlogInfo: Displays overall event information such as total number of events, newest 

sequence number, oldest sequence number, shutdown sequence number, reboot sequence number, and 
clear sequence number.

 -GetEvents: Gets event log entry details. The information shown consists of the total number of entries 
and the details of each error log entry. Start_entry specifies the initial event log entry when displaying 
the log.

 -GetSinceShutdown: Displays all the events since last controller shutdown.
 -GetSinceReboot: Displays all the events since last controller reboot.
 -IncludeDeleted: Displays all events, including deleted events.
 -GetLatest: Displays the latest number of events, if it exists. The event data is written to the file in 

reverse order.
 -Clear: Clears the event log for the selected controller(s).
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4.6 Configuration Commands

You can use the commands in this section to create storage configurations.

4.6.1 Add RAID 0 or 1 Configuration

Use the command in Table 14 to add a RAID level 0 or 1 configuration to the existing configuration on the selected 
controller. For RAID level 10, see Section 4.6.3, Add RAID 10 Configuration.

NOTE  ServeRAID C105 supports only SATA HDDs; it does not support SSD or SAS. 

Table 14  Add RAID 0 or 1 Configuration

Syntax MegaCLI –CfgLDAdd  -R0|-R1|[[E0]:Sn] [ -szXXXXXXXX [-szYYYYYYYY [...]]] 
[-strpszM] [-Hsp[E5:S5,...]] [–afterLdX]  -aN

Description

Adds a RAID level 0 or 1 configuration to a specified controller. Even if no configuration is present, you have the 
option to write the configuration to the controller.
 –Rx[[E0]:Sn]: Used to specify the RAID level and the physical drive enclosure/slot numbers for an 

array. 

NOTE  No enclosure number is needed for simple swap configurations, in which a drive is not part of an 
enclosure. For example, in a RAID 1 configuration with a drive in slot 2 that is not in an enclosure, and a drive in 
an enclosure in slot 3, the syntax is -R1[:2,1:3].

 –strpszM: Used (optionally) to specify a stripe size. You can set the stripe size to 64 Kbytes.
 –Hsp[Ex:Sx,…]: Used to create a global hotspare, with physical drive enclosure/slot numbers 

specified. 
 –szXXXX: Used to specify the size of a virtual drive, where XXXX is a decimal number of Mbytes. 

However, the actual size of the virtual drive may be smaller, because the driver requires the number of 
blocks from physical drives in each virtual drive to be aligned to the stripe size. This option also can be 
used to create a configuration on the free space available in the array.

 -AfterLdX: Used to specify which free slot should be used (optional). By default, MegaCLI uses the 
first free slot available in the array. This option has no meaning if the array is not already used for 
configuration.
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4.6.2 Configure Each Disk as RAID 0

Use the command in Table 15 to configure each drive in Unconfigured-Good state as RAID 0.

4.6.3 Add RAID 10 Configuration

Use the command in Table 16 to add a RAID 10 configuration to the existing configuration on the selected controller. 
For RAID levels 0, 1 or 5, see Section 4.6.1, Add RAID 0 or 1 Configuration.

NOTE  The MegaCLI utility does not support spanning across these single-drive RAID 0 configurations.

Table 15  Configure Each Disk as RAID 0

Syntax MegaCLI –CfgEachDskRAID0 [{WT | WB }] [{NORA | RA | ADRA}] [{Direct | 
Cached}] [{-strpszM} -aN|-a0,1,2|-aALL

Description

Configures each drive in Unconfigured-Good state as RAID 0 on this controller.
The options {WT |WB} {NORA | RA | ADRA} {Direct | Cached} must be entered in the sequence 
that is shown.
 WT: Used to select Write-through caching, in which a write transaction is considered to be complete when 

all the data has been written to the disk cache. 
 WB: Used to select Write-back caching, in which the write transaction is complete only when the data has 

been written to the disk.
 NORA: Used to select Normal Read Ahead caching, which specifies that the controller reads only the 

requested data and does not read ahead for the current virtual drive.
 RA: Used to select Read Ahead caching, which specifies that data is read sequentially ahead of the data 

that is actually requested and is stored in a cache. If the additional read-ahead data is then requested, it 
can be read faster from the cache than from the disk directly. Read-Ahead supplies sequential data faster, 
but is not as effective when accessing random data.

 ADRA: Used to select Adaptive Read Ahead, which specifies that the controller begins using Read Ahead 
caching if the two most recent disk accesses occurred in sequential sectors. If all read requests are 
random, the algorithm reverts to No Read Ahead; however, all requests are still evaluated for possible 
sequential operation.
If you select Read Ahead, there is a danger that data could be lost if the power fails before the cached data 
is written to disk.

 Direct: Used to specify that the controller does not buffer reads in cache memory. Data is transferred to 
cache and the host concurrently. If the same data block is read again, it comes from cache memory.

 Cached: Used to specify that the controller buffers all reads in cache memory.
 {-strpszM}: Used to specify the size of the segments written to each drive in the configuration. You 

can set the stripe size to 64 Kbytes.

NOTE  On a RAID 10 array, you can create only one virtual drive, and that virtual drive must occupy the entire 
space of the RAID 10 array.
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4.6.4 Clear Existing Configuration

Use the command in Table 17 to clear the existing storage configuration on the selected controller(s).

4.6.5 Display Existing Configuration

Use the command in Table 18 to display the virtual drive and drive information for the configuration on the selected 
controller(s). This command also provides information about the remaining unconfigured space.

4.6.6 Save Controller Configuration

Use the command in Table 19 to save the configuration for the selected controller(s) to the given filename.

Table 16  Add RAID 10 Configuration

Syntax MegaCLI –CfgSpanAdd -R10| –Array0[E0:Sn] –Array1[E0:Sn] [...] [{WT | WB}] 
[{NORA | RA | ADRA}] [{Direct | Cached}] [{-strpszM}] -aN

Description

Creates a RAID level 10 (spanned) configuration from the specified arrays. Even if no configuration is present, 
you must use this option to write the configuration to the controller.
Multiple arrays are specified using the –ArrayX[E0:Sn,...] option. (Note that X starts from 0, not 1.) All 
the arrays must have the same number of physical drives. At least two arrays must be provided. The options 
{WT |WB} {NORA | RA | ADRA} {Direct | Cached} must be entered in the sequence that is 
shown.

Table 17  Clear Existing Configuration

Syntax MegaCLI –CfgClr -aN|-a0,1,2|-aALL

Description Clears the existing storage configuration.

Table 18  Display Existing Configuration

Syntax MegaCLI  -CfgDsply -aN|-a0,1,2|-aALL

Description Displays the existing configuration on the selected controller(s), which includes the virtual drive and 
component physical drive-related details.

Table 19  Save Controller Configuration

Syntax MegaCLI –CfgSave  –fFileName  -aN

Description Saves the configuration for the selected controller(s) to the given filename, in binary format. The command 
also stores the controller properties structure in the file.
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4.6.7 Restore Configuration Data from File

Use the command in Table 20 to read the configuration from the file and load it on the selected controller(s). You can 
restore the read/write properties and RAID configuration using hotspares.

4.6.8 Delete Virtual Drive(s)

Use the command in Table 21 to delete one or more virtual drives on the selected controller(s).

4.6.9 Display Free Space

Use the command in Table 22 to display the free space that is available to use for configuration on the selected 
controller(s).

Table 20  Restore Configuration Data from File

Syntax MegaCLI –CfgRestore  –fFileName  -aN

Description

Reads the configuration from the file and loads it on the controller. MegaCLI can store or restore all read and 
write controller properties, all read and write properties for virtual drives, and the RAID configuration 
including hotspares. 

NOTE  The -CfgSave option stores the configuration data and the controller properties in the file. 
Configuration data has only the device ID and sequence number information of the physical drives used in the 
configuration. The CfgRestore option will fail if the same device IDs of the physical drives are not present. 
The utility does not validate the setup before restoring the configuration.

Table 21  Delete Virtual Drives

Syntax MegaCLI –CfgLDDel–Lx|-L0,1,2|-Lall -aN|-a0,1,2|-aALL

Description Deletes one virtual drive, multiple virtual drives, or all the selected virtual drives on selected controller(s).

Table 22  Display Free Space

Syntax MegaCLI –CfgFreeSpaceInfo -aN|-a0,1,2|-aALL

Description
Displays all the free space available for configuration on the selected controller(s). The information includes 
the number of disk groups, the number of spans in each disk group, the number of free space slots in each disk 
group, the start block, and the size (in both blocks and megabytes) of each free space slot.
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4.7 Virtual Drive Commands

You can use the commands in this section to select settings for the virtual drives and to perform actions on them. 

4.7.1 Display Virtual Drive Information

Use the command in Table 23 to display information about virtual drives on the selected controller(s).

4.7.2 Display Virtual Drive Disk Cache Settings

Use the command in Table 24 to display the disk cache settings for the virtual drive(s) on the selected controller(s).

4.7.3 Manage Virtual Drive Initialization

Use the command in Table 25 to manage initialization of the virtual drive(s) on the selected controller(s).

Table 23  Display Virtual Drive Information

Syntax MegaCLI –LDInfo –Lx|-L0,1,2|-Lall -aN|-a0,1,2|-aALL

Description
Displays information about the virtual drive(s) on the selected controller(s). This information includes the 
name, RAID level, RAID level qualifier, size in megabytes, state, stripe size, number of drives, and span depth. 
Also displays activity progress, if any, including initialization, background initialization, and consistency check.

Table 24  Display Virtual Drive Cache Settings

Syntax MegaCLI –LDGetProp -DskCache -Lx|-L0,1,2| -Lall -aN|-a0,1,2|-aALL

Description
Displays the disk cache settings of the virtual drive(s):
-DskCache: Displays physical drive cache policy.
ServeRAID C105 does not support setting virtual drive parameters.

Table 25  Manage Virtual Drive Initialization

Syntax MegaCLI –LDInit –Start [Fast | Full] |-Abort|–ShowProg|-ProgDsply 
-Lx|-L0,1,2|-Lall -aN|-a0,1,2|-aALL 

Description

Allows you to select the following actions for virtual drive initialization:
 -Start: Starts the initialization (writing 0s) on the virtual drive(s) and displays the progress (this is 

optional). The fast initialization option initializes the first 100 Mbytes on the virtual drive. The full option 
allows you to initialize the entire virtual drive.

 -Abort: Aborts the ongoing initialization on the LD(s). 
 -ShowProg: Displays the snapshot of the ongoing initialization, if any.
 -ProgDsply: Displays the progress of the ongoing initialization until at least one initialization is 

completed or a key is pressed.
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4.7.4 Manage Consistency Check

Use the command in Table 26 to manage a data consistency check (CC) on the virtual drives for the selected 
controller(s).

4.7.5 View Ongoing Background Initialization

Use the command in Table 27 to view ongoing background initialization of the selected virtual drives, after the 
-LDInit command has been issued to start the initialization. This function completes only when all background 
initialization processes complete or the user presses a key to exit.

4.7.6 Display Virtual Drive and Physical Drive Information

Use the command in Table 28 to display information about the virtual drives and drives for the selected controller(s), 
such as the number of virtual drives, RAID level, and drive size.

Table 26  Manage Consistency Check

Syntax MegaCLI –LDCC –Start|-Abort|–ShowProg|-ProgDsply –Lx|-L0,1,2|-Lall 
-aN|-a0,1,2|-aALL

Description

Allows you to select the following actions for a data consistency check:
 -Start: Starts a CC on the virtual drive(s), and then displays the progress (optional) and time remaining.
 -Abort: Aborts an ongoing CC on the virtual drive(s). 
 -ShowProg: Displays a snapshot of an ongoing CC.
 -ProgDsply: Displays ongoing CC progress until at least one CC is completed or a key is pressed.

Table 27  View Ongoing Background Initialization

Syntax MegaCLI –LDBI -Enbl|-Dsbl|-GetSetting|-ShowProg|-ProgDsply –Lx|
-L0,1,2|-Lall -aN|-a0,1,2|-aALL

Description

Displays ongoing background initialization of the selected virtual drives. This function completes only when all 
background initialization processes complete or the user presses a key to exit.
 -Enbl, -Dsbl: Enables or disables the background initialization on the given controller(s).
 -ProgDsply: Allows the user to view ongoing background initialization until all background 

initialization processes complete or the user presses a key to exit.
 -ShowProg: Displays current progress value.
 -GetSetting: Displays current background initialization setting (enabled or disabled).

Table 28  Display Virtual Drive and Drive Information

Syntax MegaCLI –LDPDInfo -aN|-a0,1,2|-aALL

Description
Displays information about the virtual drive(s) and the drive(s) on the selected controller(s). Displays 
information including the number of virtual drives, the RAID level of the virtual drives, and physical drive size 
information, such as raw size, coerced size, and uncoerced size.



- 53 -

ServeRAID C105 User’s Guide
May 2013

Chapter 4: MegaCLI Command Line Interface
Physical Drive Commands

4.7.7 Display Number of Virtual Drives

Use the command in Table 29 to display the number of virtual drives attached to the controller.

4.8 Physical Drive Commands

You can use the commands in this section to select settings for the drives and perform actions on them. 

4.8.1 Display Drive Information

Use the command in Table 30 to display information about the drives on the selected controller(s).

4.8.2 Set Drive State to Online

Use the command in Table 31 to set the state of a drive to Online. In an online state, the physical drive is working 
normally and is a part of a configured virtual drive.

4.8.3 Set Drive State to Offline

Use the command in Table 32 to set the state of a drive to Offline. In the offline state, the virtual drive is not available to 
the controller.

Table 29  Display Number of Virtual Drives

Syntax MegaCLI –LDGetNum –aN|-a0,1,2|-aALL

Description Displays the number of virtual drives attached to the controller. The return value is the number of virtual 
drives.

Table 30  Display Drive Information

Syntax MegaCLI –PDInfo -PhysDrv[E0:Sn....] -aN|-a0,1,2|-aALL

Description

Provides information about the drives connected to the enclosure and controller slot. This includes 
information such as the enclosure number, slot number, device ID, sequence number, drive type, capacity (if a 
drive), foreign state, and inquiry data. 
-Physdrv[E0:S0,...]: Specifies the physical drive enclosure and the slots for the drives to provide 
information about.

Table 31  Set Drive State to Online

Syntax MegaCLI –PDOnline -PhysDrv[E0:Sn....] -aN|-a0,1,2|-aALL

Description
Changes the drive state to Online.
-Physdrv[E0:S0,...]: Specifies the physical drive enclosure and the slots for the drives.

Table 32  Set Drive State to Offline

Syntax MegaCLI –PDOffline -PhysDrv[E0:S....] -aN|-a0,1,2|-aALL

Description
Changes the drive state to Offline.
-Physdrv[E0:S0,...]: Specifies the physical drive enclosure and the slots for the drives.
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4.8.4 Set Drive State to Unconfigured-Good

Use the command in Table 33 to set the state of a drive from Unconfigured-Bad to Unconfigured-Good.

4.8.5 Change the Drive State

Use the command in Table 34 to change the drive state, as it relates to hotspares, and to associate the drive to an 
enclosure.

Table 33  Set Drive State to Unconfigured-Good

Syntax MegaCLI –PDMakeGood -PhysDrv[E0:Sn...] -aN|-a0,1,2|-aALL

Description
Changes the drive state from Unconfigured-Bad to Unconfigured-Good.
 -Physdrv[E0:S0,...]: Specifies the physical drive enclosure and the slots for the drives.
 Force: Force the drive to the Unconfigured Good state.

NOTE  Software RAID does not support dedicated hotspares.

Table 34  Change Drive State

Syntax MegaCli –PDHSP {–Set [{-Dedicated -ArrayN |-Array0,1...}] [-EnclAffinity] 
[-nonRevertible] } | -Rmv -PhysDrv[E0:S0,E1:S1,...] -aN|-a0,1,2|-aALL

Description

Changes the drive state (as it relates to hotspares) and associates the drive to an enclosure and virtual drive on 
a single controller, multiple controllers, or all controllers:
 -Set: Changes the drive state for the enclosure.
 -Array0: Dedicates the hotspare to a specific drive group number N. 
 -EnclAffinity: Associates the hotspare to a selected enclosure.
 -Rmv: Changes the drive state to ready (removes the hotspare).
 -Physdrv[E0:S0,...]: Specifies the physical drive enclosure and the slots for the drives.
You can get the list of arrays by using the CLI command "CfgDsply". In the results of the CfgDsply command, 
the number associated with "DISK GROUPS" is the array number.
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4.8.6 Manage a Drive Initialization

Use the command in Table 35 to manage a drive initialization on the selected controller(s).

4.8.7 Manage Global Hotspares

Use the command in Table 36 to manage the configuration and assignment of global hotspares. Make sure the 
capacity of the hotspare drive is equal to or larger than the capacity of the disks in the array and that it is the same 
type of drive.

4.8.8 Rebuild Drive

Use the command in Table 37 to start or stop a rebuild on a drive and display the rebuild progress. When a drive in a 
drive group fails, you can rebuild the drive by recreating the data that was stored on the drive before it failed.

Table 35  Manage Drive Initialization

Syntax MegaCli –PDClear -Start |-Stop|-ShowProg |-ProgDsply 
-PhysDrv[E0:S0,E1:S1....] -aN|-a0,1,2|-aALL

Description

Manages initialization or displays initialization progress on a single controller, multiple controllers, or all 
controllers:
 -Start: Starts initialization on the selected drive(s).
 -Stop: Stops an ongoing initialization on the selected drive(s).
 -ShowProg: Displays the current progress percentage and time remaining for the initialization. This 

option is useful for running the application through scripts.
 -ProgDsply: Displays the ongoing clear progress. The routine continues to display the initialization 

progress until at least one initialization is completed or a key is pressed.

NOTE  The hotspare drive rebuilds a failed drive even if the hotspare and the drives in the drive group are 
different types of drives. Once the rebuild is completed, it is recommended that you replace the new drive 
group member with a drive of the same type.

Table 36  Manage Hotspares

Syntax MegaCLI –PDHSP {–Set | -Rmv} -PhysDrv[E0:Sn....] -aN|-a0,1,2|-aALL

Description
 -Set: Changes the drive state to hotspare for the enclosure.
 -Rmv: Changes the physical drive state to ready (removes the hotspare).

Table 37  Rebuild Drive

Syntax MegaCLI –PDRbld –Start |-Stop|-ShowProg |-ProgDsply –PhysDrv [E0:Sn....] 
-aN|-a0,1,2|-aALL 

Description

Manages a drive rebuild or displays the rebuild progress on one or more controllers. The drive must meet the 
size requirements before it can be rebuilt, and it must be part of an array:
 -Start: Starts a rebuild on the selected physical drive(s) and displays the rebuild progress (optional).
 -Stop: Stops an ongoing rebuild on the selected physical drive(s).
 -ShowProg: Displays the current progress percentage and time remaining for the rebuild. This option is 

useful for running the application through scripts.
 -ProgDsply: Displays the ongoing rebuild progress until at least one initialization is completed or a key 

is pressed.
 - Physdrv[E0:S0,...]: Specifies the physical drive enclosure and the slots for the drives.
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4.8.9 Locate Drive(s) and Activate LED

Use the command in Table 38 to locate drive(s) by flashing the drive activity LED.

4.8.10 Replace Configured Disk Drives and Start Automatic Rebuild

Use the command in Table 39 to replace a configured drive and start an automatic rebuild of the drive.

4.8.11 Prepare Unconfigured Physical Drives for Removal

Use the command in Table 40 to prepare an unconfigured drive(s) for removal from the selected controller(s).

4.8.12 Display Number of Physical Drives

Use the command in Table 41 to display the total number of drives attached to a controller.

4.8.12.1 Display List of Physical Drives

Use the command in Table 42 to display a list of the physical drives connected to the selected controller(s).

Table 38  Locate Drive and Flash LED

Syntax MegaCLI –PDLocate –Start |-Stop –PhysDrv[E0:Sn....] -aN|-a0,1,2|-aALL

Description Locates the drive(s) for the selected controller(s) and flashes the disk activity LED.

Table 39  Replace Configured Disk Drives and Start Automatic Rebuild

Syntax MegaCLI –PDReplaceMissing –PhysDrv[E0:Sn] –ArrayX –RowY -aN

Description Replaces the configured physical drives, and then starts an automatic rebuild. The specified array Index and 
row must be a missing drive.

Table 40  Prepare Unconfigured Drives for Removal

Syntax MegaCLI –PDPrpRmv [-Undo] –PhysDrv[E0:Sn....] -aN|-a0,1,2|-aALL

Description
Prepares unconfigured physical drive(s) for removal. The drive is spun down, and the drive state is set to 
unaffiliated, which marks it as offline even though it is not a part of configuration.
The -Undo option undoes this operation, and this drive is marked as Unconfigured-Good.

Table 41  Display Number of Drives

Syntax MegaCLI –PDGetNum –aN|-a0,1,2|-aALL

Description Displays the total number of drives attached to a controller. The return value is the number of drives.

Table 42  Display List of Physical Drives

Syntax MegaCLI –PDList –aN|-a0,1..|-aAll

Description Displays information about all drives connected to the selected controller(s). This information includes 
information such as the drive type, size, and serial number. 
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4.9 Miscellaneous Commands

The commands in this section are used to display various information about the MegaCLI utility.

4.9.1 Display Version Information

Use the command in Table 44 to display the CLI version, the version of the device driver, the version of the Unified 
extended firmware interface (UEFI) device driver, the firmware versions for the attached physical device, and the 
enclosure.

4.9.2 Display MegaCLI Version

Use the command in Table 44 to display the version number of the MegaCLI utility.

4.9.3 Display Help for MegaCLI

Use the command in Table 45 to display help information for the MegaCLI utility.

4.9.4 Display Summary Information

Use the command in Table 46 to display help information for the MegaCLI utility.

Table 43  Display Version Information

Syntax
MegaCLI –Version -Cli | Ctrl | Driver | Pd | Uefi | –aN

(Uefi works only for EFI.)

Description
Displays the firmware versions and other code levels installed on the controller, the CLI version, the version of 
the device driver, the version of the UEFI device driver, the firmware versions for the attached physical device, 
and enclosure in a list as location information, model string, and firmware version.

Table 44  Display MegaCLI Version

Syntax MegaCLI –v

Description Displays the version number of the MegaCLI utility.

Table 45  Display Help for MegaCLI

Syntax MegaCLI –h|–Help|?

Description Displays help for the MegaCLI utility.

Table 46  Display Summary Information

Syntax MegaCLI –ShowSummary [-f filename] -aN

Description Displays a summary of the system information, the controller information, the drive information, the virtual 
drive information, and the enclosure information.
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Chapter 5: MegaRAID Storage Manager Overview and Installation

MegaRAID Storage Manager (MSM) is a configuration and monitoring utility used with ServeRAID C100 and 
ServeRAID C105. This chapter provides a brief overview of the MegaRAID Storage Manager utility and explains how to 
install it on the supported operating systems. 

5.1 Overview

MegaRAID Storage Manager may be installed either on the local system which contains the RAID controllers that you 
wish to monitor, or on a remote system such as a workstation or a laptop with network connectivity to the system you 
wish to monitor. Because of this, the system hardware and software requirements for installing MegaRAID Storage 
Manager might differ from the system requirements for the ServeRAID controller(s) you are using.

MegaRAID Storage Manager enables you to configure, monitor, and maintain storage configurations created under 
ServeRAID C105. The MegaRAID Storage Manager graphical user interface (GUI) makes it easy for you to create and 
manage storage configurations.

5.1.1 Creating Storage Configurations

MegaRAID Storage Manager enables you to easily configure the controllers, disk drives, and virtual disks on your 
workstation or server. The Simple Configuration mode and the Advanced Configuration mode greatly simplify the 
process of creating drive groups and virtual drives. You can use the these configuration modes to create the best 
possible configuration with the available hardware. 

You can create the following types of configurations:

 Simple configuration specifies a limited number of settings and has the system select drives for you. This option 
is the easiest way to create a virtual drive.

 Advanced configuration lets you choose additional settings and customize virtual drive creation. This option 
provides greater flexibility when creating virtual drives for your specific requirements.

See Section 7.1, Creating a New Storage Configuration, for the procedures used to create storage configurations. 

5.1.2 Monitoring Storage Devices

MegaRAID Storage Manager displays the status of virtual disks, drives, and other storage devices on the workstation 
or server that you are monitoring. System errors and events are recorded in an event log file and are displayed on the 
screen. Special device icons appear on the screen to notify you of disk failures and other events that require 
immediate attention.

5.1.3 Maintaining Storage Configurations

You can use MegaRAID Storage Manager to perform system maintenance tasks such as running consistency checks 
on arrays that support redundancy.

NOTE  MegaRAID Storage Manager can be used to manage a wide range of ServeRAID controllers. Some 
MegaRAID Storage Manager features are not applicable for ServeRAID C105.
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5.2 Hardware and Software Requirements

The hardware requirements for MegaRAID Storage Manager are as follows:

 PC-compatible computer with an IA-32 (32-bit) Intel Architecture processor or an EM64T (64-bit) processor and at 
least 128 Mbytes of system memory

 Physical drive with at least 50 Mbytes available free space

The supported operating systems for the MegaRAID Storage Manager are as follows:

 Microsoft® Windows® Server versions 2008, 2008R2
 Microsoft Windows Workstation version 7 & 8
 Red Hat® Enterprise Linux™ (RHEL) versions 5 & 6
 SuSE® Linux Enterprise Server (SLES) versions 10 & 11

Refer to your server documentation and to the operating system documentation for more information on hardware 
requirements and operating system requirements.

5.3 Installation

This section explains how to install (or reinstall) MegaRAID Storage Manager on your workstation or server.

5.3.1 Installing MegaRAID Storage Manager on Microsoft Windows

Follow these steps to install MegaRAID Storage Manager on a system running a Microsoft Windows operating system.

1. Unzip the zip file containing the MegaRAID Storage Manager in Windows Explorer.

2. Double-click the setup.exe file to start the installation program.

3. When the Welcome screen appears, click Next.

If MegaRAID Storage Manager is already installed on this system, the Program Maintenance screen appears. Read 
the screen text and select Modify, Repair, or Remove.

4. When the next screen appears, read and accept the user license, and click Next.

The Customer Information screen appears, as shown in the following figure.

NOTE  It is recommended that you use at least 1 Gbyte of system memory.

NOTE  MegaRAID Storage Manager supports the RHEL6 operating system (OS) with a few prerequisites. 
By nature, the RHEL6 OS default installation deploys only limited inbox libraries though it is shipped in 
the CD image for the full installation. This design from the RHEL6 OS adds an overhead for the Java® 
application programming users, and a few required libraries are not deployed during the default RHEL6 
operating system installation. Because of this, you can either install the additional libraries or run a native 
64-bit version of MSM.



- 60 -

ServeRAID C105 User’s Guide
May 2013

Chapter 5: MegaRAID Storage Manager Overview and Installation
Installation

Figure 26  Customer Information Screen

5. Enter your user name and organization name. In the bottom part of the screen, select an installation option:

— If you select All users, any user with administrative privileges can use this version of MegaRAID Storage 
Manager to view or change storage configurations.

— If you select Only for current user, the MegaRAID Storage Manager shortcuts and associated icons will be 
available only to the user with this user name.

6. Click Next to continue.

7. On the next screen, accept the default Destination Folder, or click Change to select a different destination folder. 
Click Next to continue.

The Setup Type screen appears, as shown in the following figure.

Figure 27  Setup Type Screen

8. Select one of the Setup options. The options are fully explained in the screen text. 

— Normally, you would select Complete if you are installing MegaRAID Storage Manager on a server. This 
option installs the complete MSM.

— Select Client if you are installing MegaRAID Storage Manager on a PC that will be used to view and configure 
servers over a network.
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Master GUI, Monitor Configurator, Help files for both MSM and Monitor Confgurator, and DebugLog are 
available. The following are not available: Popup, SNMP, Monitor, Framework, Storelib and Storelib-IR, 
StorelibJNI and StorelibIRJNI.

— Select Server to install only those components required for remote server management.

Popup, SNMP, Monitor, Framework, Storelib and Storelib-IR, StorelibJNI and StorelibIRJNI are available. Master 
GUI, Monitor Configurator, Help files for both MSM and Monitor Confgurator, and DebugLog are not 
available.

— Select StandAlone to use MegaRAID Storage Manager to create and manage storage configurations on a 
standalone workstation. 

All of the components are available except for the Network Capability Plugin.

9. Click Next to proceed.

10. Click Install to install the program.

11. Click Finish when the final Configuration Wizard screen appears.

If you select Client installation for a PC used to monitor servers, and if there are no available servers with a registered 
framework on the local subnet (that is, servers with a complete installation of MegaRAID Storage Manager), you 
cannot connect to a remote server unless you first edit the startupui.bat file. Specifically, you must add the IP 
address of the remote server to the end of the startupui.bat file.

For example, to connect to a remote framework on server 192.168.0.10, add the IP address to the end of 
startupui.bat as shown in this example:

start JRE\bin\javaw -classpath .;GUI.jar GUI.VivaldiStartupDialog
ajsgyqkj=71244 192.168.0.10

Be sure to include a space in front of the IP address, as shown in the example.

5.3.2 Installing MegaRAID Storage Manager for Linux

Follow these steps if you need to install MegaRAID Storage Manager on a system running Linux:

1. Copy the MSM_linux_installer...tar.gz file to a temporary folder.

2. Untar the MSM_linux_installer...tar.gz file using the following command: 

tar -zxvf MSM_linux_installer...tar.gz

A new disk directory is created.

3. Go to the new disk directory.

4. In the disk directory, find and read the readme.txt file.

5. To start the installation, enter the following command:

./install.sh

If you select Client installation for a PC used to monitor servers, and if there are no available servers with a registered 
framework on the local subnet (that is, servers with a complete installation of MegaRAID Storage Manager), you 
cannot connect to a remote server unless you first edit the startupui.sh file. Specifically, you must add the IP 
address of the remote server to the end of the startupui.sh file.

For example, to connect to a remote framework on server 192.168.0.10, add the IP address to startupui.sh as 
shown in this example:

start JRE\bin\javaw -classpath .;GUI.jar GUI.VivaldiStartupDialog
ajsgyqkj=71244 192.168.0.10

Be sure to include a space in front of the IP address, as shown in the example.
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5.3.3 Linux Installation Messages

One or more of the following messages may appear while you are installing MegaRAID Storage Manager on a Linux 
system:

 More than one copy of MegaRAID Storage Manager has been installed.

This message indicates that the user has installed more than one copy of MegaRAID Storage Manager. (This can 
be done by using the rpm-force command to install the rpm file directly, which is not recommended, instead of 
using the install.sh file.) In such cases, the user must uninstall all the rpm files manually before installing 
MegaRAID Storage Manager with the procedure listed previously.

 The version is already installed.

This message indicates that the version of MegaRAID Storage Manager you are trying to install is already installed 
on the system.

 The installed version is newer.

This message indicates that a version of MegaRAID Storage Manager is already installed on the system, and it is a 
newer version than the version you are trying to install.

 Exiting installation.

This message appears when the installation is complete.

 RPM installation failed.

This message indicates that the installation failed for some reason. Additional message text explains the cause of 
the failure.
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Chapter 6: MegaRAID Storage Manager Screens and Menus

This chapter explains how to start MegaRAID Storage Manager and describes the MegaRAID Storage Manager screens 
and menus. 

6.1 Starting MegaRAID Storage Manager

Follow these steps to start MegaRAID Storage Manager and view the main menu screen:

1. Start the program using the method required for your operating system environment:

— To start MegaRAID Storage Manager on a Microsoft Windows system, select Start > Programs > 
MegaRAID Storage Manager > StartupUI, or double-click the MegaRAID Storage Manager shortcut on the 
desktop.

— To start MegaRAID Storage Manager on a RHEL system, select Applications > System Tools > 
MegaRAID Storage Manager StartupUI.

— To start MegaRAID Storage Manager on a SUSE system, select Start > System > More Programs -> 
MegaRAID Storage Manager.

When the program starts, the Select Server window appears, as shown in the following figure.

Figure 28  Select Server Window

NOTE  If a warning appears stating that Windows Firewall has blocked some features of the program, 
click Unblock to allow MegaRAID Storage Manager to start. (The Windows Firewall sometimes blocks 
the operation of programs that use Java.)
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If the circle in the server icon is yellow instead of green, it means that the server is running in a degraded 
state—for example, because a disk drive used in a virtual disk has failed. If the circle is red, the storage 
configuration in the server has failed.

2. Double-click the icon of the server that you want to access. 

The Server Login window appears, as shown in the following figure.

Figure 29  Server Login Window

3. Enter your user name and your password.

The question mark icon opens a dialog box that explains what you need for full access to the server and for 
view-only access to the server.

4. Select an access mode from the drop-down menu.

— Select Full Access if you need to both view the current configuration and change the configuration.
— Select View Only if you need to only view and monitor the configuration.

5. Click Login.

6. Enter the root/administrator user name and password to use the Full Access mode. 

If your user name and password are correct for the Login mode you have chosen, the MegaRAID Storage Manager 
main menu appears.

NOTE  To access servers on a different subnet, type in the box at the bottom of the screen the IP address 
of a server in the desired subnet where MegaRAID Storage Manager is running, and click Update. If you 
check the Connect to remote Framework box, you can also access a standalone installation of 
MegaRAID Storage Manager, if it has a network connection.

NOTE  If the computer is networked, this is the login to the computer itself, not the network login.
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6.2 MegaRAID Storage Manager Screen

This section describes the MegaRAID Storage Manager main menu screen, which is shown in the following figure.

Figure 30  MegaRAID Storage Manager Main Menu Screen

The following topics describe the panels and menu options that appear on this screen.

6.2.1 Dashboard/Physical View/Logical View

The left panel of the ServeRAID C105 main menu screen displays the Dashboard view, the Physical view, or the Logical 
view of the system and the attached devices, depending on which tab is selected.

6.2.1.1 Dashboard View

The Dashboard view shows an overview of the system and covers the following features:

 Properties of the virtual drives and the physical drives
 Total capacity, configured capacity, and unconfigured capacity
 Background operations in progress
 MSM features and their status (enabled or disabled)
 Actions you can perform
 Links to Online Help

The following figure shows the Dashboard view.
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Figure 31  MegaRAID Storage Manager Dashboard View

6.2.1.2 Physical view

The Physical view shows the hierarchy of physical devices in the system. At the top of the hierarchy is the system itself, 
followed by the controller and the backplane. One or more controllers are installed in the system. The controller label 
identifies the controller so that you can easily differentiate between multiple controllers. Each controller has one or 
more ports. Drives and other devices are attached to the ports. The properties for each item appear in the right panel 
of the screen under the Properties tab.

The following figure shows the Physical view and the Properties tab.
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Figure 32  MegaRAID Storage Manager Physical View

6.2.1.3 Logical View

The Logical view shows the hierarchy of controllers, virtual drives, and the drives and drive groups that make up the 
virtual drives. The properties for these components appear in the right panel under the Properties tab.

The following figure shows the Logical view and the Properties tab.

Figure 33  MegaRAID Storage Manager Logical View
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The following icons in the left panel represent the controllers, disk drives, and other devices:

  - Status
  - System
  - Controller
  - Backplane
  - Port
  - Drive group
  - Virtual drive
  - Online drive
  - Global hotspare
  - Tape drive
  - CD-ROM
  - Foreign drive
  - Unconfigured foreign drive
  - Unconfigured drive

A red circle to the right of an icon indicates that the device has failed. For example, this icon indicates that a physical 
drive has failed: . 

A yellow circle to the right of an icon indicates that a device is running in a degraded state. For example, this icon 
indicates that a virtual disk is running in a degraded state because a disk drive has failed: .

6.2.2 Event Log Panel

The lower part of the MegaRAID Storage Manager main menu screen displays the system event log entries, as shown 
in Figure 30. New event log entries appear during the session. Each entry has a timestamp and date, an error level 
indicating the severity of the event, and a brief description of the event. 

For more information about the event log, see Section 8.1, Monitoring System Events. For more information about the 
event log entries, see Appendix A, ServeRAID C100 and ServeRAID C105 MegaRAID Storage Manager Events and 
Messages.

6.2.3 Menu Bar

Here are brief descriptions of the main selections on the MegaRAID Storage Manager menu bar. Specific menu 
options are described in more detail in Chapter 7, Chapter 8, and Chapter 9 of this manual.

6.2.3.1 Manage Menu

The Manage menu has a Refresh option for updating the display in the ServeRAID C105 main menu screen (refresh is 
seldom required; the display normally updates automatically) and an Exit option to end your session on ServeRAID 
C105. The Server menu item shows all the servers that were discovered by a scan. In addition, you can perform a check 
consistency, initialize multiple virtual groups, and show the progress of group operations on virtual drives.

NOTE  MegaRAID Storage Manager shows the icons for tape drive devices; however, no tape-related 
operations are supported by the utility. If these operations are required, use a separate backup 
application.
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6.2.3.2 Go To Menu

The Go To menu is available when you select a controller, drive group, physical drive, virtual drive, or battery backup 
unit in the main menu screen. The menu options vary depending on the type of device selected in the left panel of the 
ServeRAID C105 main menu. The options also vary depending on the current state of the selected device. For 
example, if you select an offline drive, the Make Drive Online option appears in the Physical Drive menu.

Configuration options are also available. This is where you access the Configuration Wizard that you use to perform 
configuration drive groups and virtual drives. To access the Wizard, select the controller in the left panel, and then 
select Go To > Controller > Create Virtual Drive.

6.2.3.3 Log Menu

The Log menu includes options for saving and clearing the message log. For more information, see Appendix A, 
ServeRAID C100 and ServeRAID C105 MegaRAID Storage Manager Events and Messages.

6.2.3.4 Tools Menu

On the Tools menu you can select Tools > Configure Alerts to access the Configure Alerts screen, which you can use 
to set the alert delivery rules, event severity levels, exceptions, and email settings. For more information, see 
Section 8.2, Configuring Alert Notifications.

6.2.3.5 Help Menu

On the Help menu you can select Help > Contents to view the Online Help for MegaRAID Storage Manager. You can 
select Help > About MegaRAID Storage Manager to view version information for the MegaRAID Storage Manager.

NOTE  When you use the Online Help for MegaRAID Storage Manager, you might see a warning message that 
Internet Explorer has restricted the file from showing active content. If this warning appears, click on the 
active content warning bar and enable the active content.

NOTE  If you are using the Linux operating system, you must install the Firefox® browser or the Mozilla® 
browser for the MegaRAID Storage Manager Online Help to display. 
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Chapter 7: Configuration

This chapter explains how to use MegaRAID Storage Manager to create and modify storage configurations on 
ServeRAID controllers.

The controllers support RAID 0, RAID 1, and RAID 10 storage configurations. The Configuration Wizard allows you to 
easily create new storage configurations and modify the configurations. To learn more about RAID and RAID levels, 
see Section 1.3, RAID Overview.

7.1 Creating a New Storage Configuration

You can use the MegaRAID Storage Manager Configuration Wizard to create new storage configurations. To open the 
MegaRAID Storage Manager Configuration Wizard, select a controller in the left panel of the MegaRAID Storage 
Manager main menu screen and then select Operations > Advanced Operations > Configuration > 
Configuration Wizard.

You can use the ServeRAID C105 to create new storage configurations on systems with ServeRAID controllers. You can 
create the following types of configurations:

 Simple configuration specifies a limited number of settings and has the system select drives for you. This option 
is the easiest way to create a virtual drive.

 Advanced configuration lets you choose additional settings and customize virtual drive creation. This option 
provides greater flexibility when creating virtual drives for your specific requirements.

This section describes the virtual drive parameters and explain how to create simple and advanced storage 
configurations.

7.1.1 Selecting Virtual Drive Settings

This section describes the virtual drive settings that you can select when you use the advanced configuration 
procedure to create virtual drives. You should change these parameters only if you have a specific reason for doing so. 
It is usually best to leave them at their default settings.

 Initialization state: Initialization prepares the storage medium for use. Specify the initialization status:
— No Initialization: (the default) The new configuration is not initialized and the existing data on the drives is not 

overwritten. 
— Fast Initialization: This option allows you to start writing data to the virtual drive immediately.
— Full Initialization: A complete initialization is done on the new configuration. You cannot write data to the 

new virtual drive until the initialization is complete. This can take a long time if the drives are large.
 Stripe size: The setting is 64 KB only.
 Access policy: Select the type of data access that is allowed for this virtual drive.

— Read/Write: (the default) Allow read/write access. This is the default.
— Read Only: Allow read-only access.
— Blocked: Do not allow access.

 Disk cache policy: Select a cache setting for this drive: 
— Enabled: Enable the disk cache.
— Disabled: Disable the disk cache.
— Unchanged: (the default) Leave the current disk cache policy unchanged.

NOTE  You cannot create or modify a storage configuration unless you are logged on to a server with 
administrator privileges.
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7.1.2 Creating a Virtual Drive Using Simple Configuration

Simple configuration is the quickest and easiest way to create a new storage configuration. When you select simple 
configuration mode, the system creates the best configuration possible using the available drives.

Follow these steps to create a new storage configuration in simple configuration mode.

1. Click the Dashboard tab on the MSM main menu screen.

The Create Virtual Drive option appears in the Actions section of the Dashboard, as shown in the following figure.

Figure 34  Virtual Drive Creation Menu

2. Click Create Virtual Drive in the Actions section of the screen.

The dialog box for the configuration mode (Simple or Advanced) appears, as shown in the following figure.

NOTE  You cannot created spanned drives using the simple configuration procedure. To create spanned 
drives, use the advanced configuration procedure described in Section 7.1.3, Creating a Virtual Drive 
Using Advanced Configuration.
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Figure 35  Virtual Drive Simple Configuration Mode

3. Click Simple and press Next.

The Create Virtual Drive screen appears, as shown in the following figure.

Figure 36  Create Virtual Drive Screen

4. Select the RAID level desired for the virtual drive.

When you use simple configuration, the RAID controller supports RAID level 1. In addition, it supports 
independent drives (configured as RAID 0). The screen text gives a brief description of the RAID level that you 
select. The RAID levels that you can choose depend on the number of drives available. To learn more about RAID 
levels, see Section 1.3, RAID Overview. 

5. Use the drop-down menu in the Virtual drives field to choose how many virtual drives you want to create.

6. Select the capacity of the virtual drive(s).

Each virtual drive has the same capacity.
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7. Click Next.

The Create Virtual Drive - Summary window appears, as shown in the following figure. This window shows the 
selections you made for simple configuration.

Figure 37  Create Virtual Drive - Summary Window

8. Click Back to return to the previous screen to change any selections or click Finish to accept and complete the 
configuration. 

The new virtual drive is created after you click Finish. After the configuration is completed, a dialog box notifies 
you that the virtual drives were created successfully.

7.1.3 Creating a Virtual Drive Using Advanced Configuration

The advanced configuration procedure provides an easy way to create a new storage configuration. Advanced 
configuration gives you greater flexibility than simple configuration because you can select the drives and the virtual 
drive parameters when you create a virtual drive. In addition, you can use the advanced configuration procedure to 
create spanned drive groups.

Follow these steps to create a new storage configuration in the advanced configuration mode. This example shows 
the configuration of a spanned drive group.

1. Click the Dashboard tab on the MSM main menu screen.

The Create Virtual Drive option appears in the Actions section of the Dashboard, as shown in the following figure.
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Figure 38  Virtual Drive Creation Menu

2. Click Create Virtual Drive in the Actions section of the screen.

The dialog box for the configuration mode (Simple or Advanced) appears, as shown in the following figure.

Figure 39  Virtual Drive Advanced Configuration Mode
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3. Click Advanced and then click Next. 

The Create Drive Group Settings dialog box appears, as shown in the following figure.

Figure 40  Create Drive Group Settings Dialog Box

4. Select the following items on the Create Drive Group Settings dialog box:

a. Select the RAID level desired for the drive group from the drop-down menu.

Drive Group 1 appears in the Drive groups field.

The RAID controller supports RAID levels 1 and 10. In addition, it supports independent drives configured as 
RAID 0. The screen text gives a brief description of the RAID level you select. RAID levels you can choose 
depend on the number of drives available. 

b. Select unconfigured drives from the list of drives and click Add> to add them to the drive group.

The selected drives appear under Span {number} below Drive Group {number}.
c. If you are creating a RAID 10 drive group, perform the following steps; if not, go to step g.

d. Click Create Span to create a second span in the drive group. 
e. Select unconfigured drives from the list of drives and click Add> to add them to the second drive group.

The selected drives appear in the second span under Span {number} below the second drive group, Drive 
Group {number}.

f. Click Create Drive Group to make a drive group with the spans.
g. Click Next to complete the steps for RAID 10 configuration.
h. Click Create Drive Group to make a drive group.
i. Click Next to complete this step.

The Virtual drive settings window appears, as shown in the following figure. The drive group and the default 
virtual drive settings appear. The options to update the virtual drive or remove the virtual drive are grayed 
out until you create the virtual drive.

NOTE  On a RAID 10 array, you can create only one virtual drive, and that virtual drive must occupy 
the entire space of the RAID 10 array.
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Figure 41  Virtual Drive Settings Dialog Box

j. Change any virtual drive settings, if desired.

See Section 7.1.1, Selecting Virtual Drive Settings, for more information about the virtual drive settings.

5. Click Create Virtual Drive.

The new virtual drive appears under the drive group. The options Update Virtual Drive and Remove Virtual 
Drive are available. Update Virtual Drive allows you to change the virtual drive settings, and Remove Virtual 
Drive allows you to delete the virtual drive.

6. Click Next.

The Create Virtual Drive - Summary window appears, as shown in the following figure. This window shows the 
selections you made for the advanced configuration.
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Figure 42  Virtual Drive Summary Window

7. Click Back to return to the previous screen to change any selections or click Finish to accept and complete the 
configuration. 

After you click Finish, the new storage configuration is created and initialized. 

After the configuration is completed, a dialog box notifies you that the virtual drives were created successfully. If 
more drive capacity exists, the dialog box asks whether you want to create more virtual drives. If no more drive 
capacity exists, you are prompted to close the configuration session.

8. Select Yes or No to indicate whether you want to create additional virtual drives.

If you select Yes, the system takes you to the Create Virtual Drive screen, as shown in Figure 36. If you select No, 
the utility asks whether you want to close the wizard.

9. If you selected No in the previous step, select Yes or No to indicate whether you want to close the wizard.

If you select Yes, the configuration procedure closes. If you select No, the dialog box closes and you remain on the 
same page.

7.2 Changing Adjustable Task Rates

Follow these steps if you need to change the adjustable rates for rebuilds, and other system tasks that run in the 
background:

NOTE  It is recommended that you leave the adjustable task rates at their default settings to achieve the best 
system performance. If you raise the task rates above the defaults, foreground tasks will run more slowly and 
it might seem that the system is not responding. If you lower the task rates below the defaults, rebuilds and 
other background tasks might run very slowly and might not complete within a reasonable time. If you decide 
to change the values, record the original default value here so you can restore them later, if necessary:
Rebuild Rate: ____________
Background Initialization (BGI) Rate: ____________
Check Consistency Rate: ____________
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1. Select Go To > Controller > Set Adjustable Task Rates from the menu bar, as shown in the following figure.

Figure 43  Set Adjustable Task Rates Menu

The Set Adjustable Task Rates dialog box appears, as shown in the following figure.

Figure 44  Set Adjustable Task Rates Dialog Box

NOTE  Select a controller icon in the Physical tab or the Logical tab in the left panel of the ServeRAID C105 
main menu screen.
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2. Enter changes, as needed, to the following task rates:

— Rebuild Rate
— Patrol Read
— Background Initialization (BGI) (for fast initialization)
— Check Consistency (for consistency checks).
— Reconstruction 

Each task rate can be set from 0 to 100 percent. The higher the number, the faster the activity runs in the 
background, possibly impacting other system tasks.

3. Click OK to accept the new task rates.

4. When the warning message appears, click OK to confirm that you want to change the task rates.

7.3 Changing Virtual Drive Properties

You can change the Read Policy, Write Policy, and other virtual drive properties at any time after a virtual drive is 
created. Follow these steps to change the virtual drive properties.

1. Select a virtual drive icon in the Physical tab or the Logical tab in the left panel of the ServeRAID C105 main 
menu screen.

2. Select Go To > Virtual Drive > Set Virtual Drive Properties from the menu bar, as shown in the following figure.

Figure 45  Set Virtual Drive Properties Menu

The Set Virtual Drive Properties dialog box appears, as shown in the following figure.
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Figure 46  Set Virtual Drive Properties Screen

3. Change the virtual drive properties as needed. 

For information about these properties, see Section 7.1.1, Selecting Virtual Drive Settings.

4. Click Ok to accept the changes.

The virtual drive settings are updated.

7.4 Deleting a Virtual Drive

You can delete virtual drives to rearrange the storage space. To delete a virtual drive, follow these steps.

1. Back up all user data that is on the virtual drive you want to delete.

2. On the MegaRAID Storage Manager main menu screen, select the Logical tab, and click the icon of the virtual 
drive you want to delete.

3. Select Go To > Virtual Drive > Delete Virtual Drive.

4. When the warning messages appear, click Yes to confirm that you want to delete the virtual drive.

You are asked twice whether you want to delete a virtual disk to avoid deleting the virtual disk by mistake.

NOTE  Be sure to back up the data that is on the virtual drive before you delete it. Be sure that the operating 
system is not installed on this virtual drive.
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Chapter 8: Monitoring System Events and Storage Devices

The MegaRAID Storage Manager enables you to monitor the status of disk drives, virtual disks, and other storage 
devices. 

8.1 Monitoring System Events

MegaRAID Storage Manager monitors the activity and performance of all controllers in the system and the storage 
devices connected to them. When an event occurs (such as the creation of a new virtual disk or the removal of a 
physical drive) an event message appears in the log displayed at the bottom of the MegaRAID Storage Manager main 
menu screen, as shown in the following figure.

You can use MegaRAID Storage Manager to alert you about events. There are settings are for the delivery of alerts, the 
severity level of events, exceptions, and email settings.

Figure 47  Event Information Window

Each message that appears in the event log has a severity level that indicates the importance of the event, a date and 
timestamp, and a brief description. You can click an event to display the same information in a window. (For a list of all 
events, see Appendix A, ServeRAID C100 and ServeRAID C105 MegaRAID Storage Manager Events and Messages.) 
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The Log menu has four options:

 Save: Saves the current log to a .log file.
 Save as Text: Saves the current log in .txt format.
 Clear: Clears the current log information. You have the option of saving the log first.
 Load: Enables you to load a local .log file.

The following figure shows the log menu.

Figure 48  Log Menu

8.2 Configuring Alert Notifications

The Alert Notification Configuration feature allows you to control and configure the alerts that ServeRAID C105 sends 
when various system events occur. 

To access the Alert Notification Configuration screen, select Tools > Configure Alerts on the main menu screen, as 
shown in the following figure. 

Figure 49  Alert Notification Configuration Menu
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The Alerts Notification Configuration screen appears, as shown in the following figure. The screen contains three tabs: 
Alert Settings, Mail Server, and Email. You can use each tab to perform tasks for that topic.

Figure 50  Alerts Notification Configuration Screen

You can select the Alert Settings tab to perform the following actions:

 Select the methods for the delivery of alerts.
 Change the severity level of events.
 Save an .xml backup file of the entire alert configuration.
 Load all of the values from a previously saved backup into the dialog to edit or send to the monitor.

You can select the Mail Server tab to perform the following actions:

 Enter or edit the sender e-mail address.
 Enter the SMTP server.
 Require authentication of the email server.
 Save an .xml backup file of the entire alert configuration.
 Load all of the values from a previously saved backup into the dialog to edit or send to the monitor.

CAUTION  When you load a saved backup file, all unsaved changes made in the current session are lost.

CAUTION  When you load a saved backup file, all unsaved changes made in the current session will be 
lost.
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You can select the Email tab to perform the following actions:

 Add new email addresses for recipients of alert notifications.
 Send test messages to the recipient email addresses.
 Remove email addresses of recipients of alert notifications.
 Save an .xml backup file of the entire alert configuration.
 Load all of the values from a previously saved backup into the dialog to edit or send to the monitor.

8.2.1 Setting Alert Delivery Methods

You can select the methods used to send alert deliveries, including by popup, email, system log, or MSM log. You can 
select the alert delivery methods for each event severity level (Information, Warning, Critical and Fatal). 

Perform the following steps to select the alert delivery methods:

1. On the Alerts Notification Configuration screen, click the Alerts Setting tab.

2. Under the Alerts Delivery Methods heading, select one of the severity levels.

3. Click Edit.

The Alert Notification Delivery Methods dialog box appears, as shown in the following figure.

Figure 51  Alert Notification Delivery Methods Dialog Box

4. Select the desired alert delivery methods for alert notifications at the event severity level.

5. Click OK to set the delivery methods used for the severity level that you selected.

CAUTION  When you load a saved backup file, all unsaved changes made in the current session will be 
lost.
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8.2.2 Changing Alert Delivery Methods for Individual Events

You can change the alert delivery options for an event without changing the severity level.

1. On the Alerts Notification Configuration screen, click the Alerts Setting tab.

The the Alerts Setting portion of the screen appears, as shown in the following figure. 

2. Click Change Individual Events.

The Change Individual Events dialog box appears, as shown in the following figure. The dialog box shows the 
events by their ID number, description, and severity level.

Figure 52  Change Individual Events Dialog Box

3. Click an event in the list to select it.

The current alert delivery methods appear for the selected event under the Alert Delivery Methods heading.

4. Select the desired alert delivery methods for the event.

5. Press ESC to return to the Alerts Notification Configuration screen.

6. Click OK.

This action saves all of the changes made to the event.
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8.3 Changing the Severity Level for Individual Events

To change the event severity level for a specific event, perform the following steps.

1. On the Alerts Notification Configuration screen, click the Alerts Setting tab.

The Alerts Setting portion of the screen appears.

2. Click Change Individual Events.

The Change Individual Events dialog box appears, as shown in the following figure. The dialog box shows the 
events by their ID number, description, and severity level.

3. Click an event in the list to select it.

The current alert delivery methods appear for the selected event.

4. Click the Severity cell for the event.

The Event Severity drop-down menu appears for that event, as shown in the following figure.

Figure 53  Change Individual Events Severity Level Menu

5. Select a different severity level for the event from the menu.

6. Press ESC to return to the Alerts Notification Configuration screen.

7. Click OK to save all of the changes made to the events.
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8.3.1 Multiple Events Displayed in a Single Pop-up Window

You can view multiple events in a single pop-up window as shown in the following figure.

Figure 54  Pop-up for Multiple Events

8.3.2 Entering or Editing the Sender Email Address and SMTP Server

You can use the Alerts Notification Configuration screen to enter or edit the sender e-mail address and the SMTP 
server. 

1. On the Alerts Notification Configuration screen, click the Mail Server tab.

The Mail Server options appear, as shown in the following figure. 
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Figure 55  Mail Server Options

2. Enter a new sender email address in the Sender email address field or edit the existing sender email address.

3. Click OK.

8.3.3 Authenticating a Server

You can use the Alerts Notification Configuration screen to authenticate the SMTP server, providing an extra level of 
security. The authentication check box enables the User name and Password fields when selected by default. 
Clearing the check box disables these fields.

Perform the following steps to enter or edit the address:

1. On the Alerts Notification Configuration screen, click the Mail Server tab.

The Mail Server options appears, as shown in the following figure. The authentication check box is selected by 
default.

2. Enter a user name in the User name field.

3. Enter the password in the Password field.

4. Click OK.
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8.3.4 Saving Backup Configurations

You can save an .xml backup file of the entire alert configuration. This includes all the settings on the three tabs.

1. On the Alerts Notification Configuration screen, click the Alert Setting tab, Mail Server tab, or Email tab.

2. Click Save Backup.

The drive directory appears.

3. Enter a filename with an .xml extension for the backup configuration (in the format filename.xml).

4. Click Save.

The drive directory disappears.

5. Click OK.

The backup configuration is saved and the Alert Notification Configuration screen closes.

8.3.5 Loading Backup Configurations

You can load all of the values from a previously saved backup into the dialog (all tabs) to edit or send to the monitor. 

1. On the Alerts Notification Configuration screen, click the Alert Setting tab, Mail Server tab, or Email tab.

2. Click Load Backup.

A message warns that when you load a saved backup file, all unsaved changes made in the current session will be 
lost. 

3. Click Yes.

The drive directory appears, from which you can select a backup configuration to load.

4. Select the backup configuration file (it should be in .xml format).

5. Click Open.

The drive directory disappears.

6. Click OK.

The backup configuration is loaded and the Alerts Notification Configuration screen closes.

NOTE  If you choose to load a backup configuration and the Configure Alerts dialog currently contains 
changes that have not yet been sent to the monitor, the changes will be lost. You are prompted to confirm 
your choice.
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8.3.6 Adding Email Addresses of Recipients of Alert Notifications

The Email tab portion of the Alerts Notification Configuration screen shows the email addresses of recipients of the 
alert notifications. MegaRAID Storage Manager sends alert notifications to those email addresses. Use the screen to 
add or remove email addresses of recipients, and to send test messages to recipients that you add.

To add email addresses of recipients of the alert notifications, perform the following steps:

1. Click the E-mail tab on the Event Notification Configuration screen.

The E-mail section of the screen appears, as shown in the following figure.

Figure 56  Email Settings

2. Enter the email address you want to add in the New recipient email address field.

3. Click Add.

The new email address appears in the Recipient email addresses field.

8.3.7 Testing Email Addresses of Recipients of Alert Notifications

Use the Email tab portion of the Alerts Notification Configuration screen to send test messages to the email addresses 
that you added for the recipients of alert notifications.

1. Click the E-mail tab on the Event Notification Configuration screen.

The E-mail section of the screen appears, as shown in the following figure.

2. Click an email address in the Recipient email addresses field.

3. Click Test.

4. Confirm whether the test message was sent to the email address. 

If MegaRAID Storage Manager cannot send an email message to the email address, an error message appears.
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8.3.8 Removing Email Addresses of Recipients of Alert Notifications

Use the Email tab portion of the Alerts Notification Configuration screen to remove email addresses of the recipients 
of alert notifications.

1. Click the E-mail tab on the Event Notification Configuration screen.

The E-mail section of the screen appears, as shown in the following figure.

2. Click an email address in the Recipient email addresses field.

The Remove button, which was grayed out, is now active.

3. Click Remove.

The email address is deleted from the list.

8.4 Monitoring Controllers

When MegaRAID Storage Manager is running, you can see the status of all controllers in the left panel of the 
MegaRAID Storage Manager main menu screen. If the controller is operating normally, the controller icon looks like 
this: . If the controller has failed, a small red circle appears to the right of the icon. See Section 6.2.1, 
Dashboard/Physical View/Logical View, for a complete list of device icons.

To display complete controller information, click a controller icon in the left panel of the MegaRAID Storage Manager 
main menu screen, and click the Properties tab in the right panel. The following figure shows the Controller 
Information properties.

NOTE  The ServeRAID C105 drivers act as virtual “controllers.” Because these are not actual hardware storage 
controllers installed in the computer system, some of the controller properties shown in the screen below do 
not apply to them.
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Figure 57  Controller Information Properties

Most of the information on this screen is self-explanatory. Note that the Rebuild Rate, Consistency Check Rate, and BGI 
Rate (background initialization) options are all user selectable. For more information, see Section 7.2, Changing 
Adjustable Task Rates.

8.5 Monitoring Disk Drives

When MegaRAID Storage Manager is running, you can see the status of all drives in the left panel of the MegaRAID 
Storage Manager main menu screen. If the disk drive is operating normally, its icon looks like this: . If the disk drive 
has failed, a small red circle appears to the right of the icon, like this: . See Section 6.2.1, Dashboard/Physical 
View/Logical View, for a complete list of device icons.

To display complete disk drive information, click a disk drive icon in the left panel of the MegaRAID Storage Manager 
main menu screen, and click the Properties tab in the right panel. 
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The following figure shows the Properties panel for a physical drive.

Figure 58  Physical Drive Information

The information on this panel is self-explanatory. There are no user-selectable properties for physical devices. Icons for 
other storage devices such as CD-ROM drives and DAT drives may also appear in the left panel.

If the drives are in a drive enclosure, you can identify which drive is represented by each drive LED on the enclosure. 
Follow these steps to locate the drive:

1. Click the drive icon in the left panel.

2. Click Go To > Physical Drive > Start Locating Drive.

The LED on the drive in the enclosure starts blinking to show its location.

3. To stop the drive LED on the enclosure from blinking, select Go To > Physical Drive > Stop Locating Drive.

To display a graphical view of a drive, click a drive icon in the left panel of the ServeRAID C105 main menu screen, and 
click the Graphical View tab. In Graphical View, the drive’s storage capacity is color coded according to the legend 
shown on the screen: configured space is blue, available space is white, and reserved space is red. When you select a 
virtual drive from the drop-down menu, the drive space used by that virtual drive is displayed in green.

NOTE  LEDs on drives that are global hotspares do not blink.
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8.6 Running a Patrol Read

A patrol read periodically verifies all sectors of drives connected to a controller, including the system reserved area in 
the RAID configured drives. A patrol read can be used for all RAID levels and for all hotspare drives. This operation is 
initiated only when the controller is idle for a defined time period and has no other background activities. 

You can set the patrol read properties and start the patrol read operation, or you can start the patrol read without 
changing the properties.

To set the patrol read properties and then start a patrol read, follow these steps:

1. Click a controller icon in the left panel of the ServeRAID C105 main menu.

2. Select Go To > Controller > Set Patrol Read Properties.

Figure 59  Start Patrol Read Menu

The Patrol Read - Set properties screen displays, as shown in the following figure.
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Figure 60  Patrol Read Configuration

3. Select a mode for a patrol read from these options: 

— Automatic: Patrol read runs automatically at the time interval you specify on this screen.
— Manual: Patrol read runs only when you manually start it by selecting Start Patrol Read from the controller 

Options panel.
— Disabled: Patrol read does not run.

4. Specify a maximum count of drives to include in the patrol read. 

The count must be from 1 to 8 drives. Eight drives is the maximum supported by ServeRAID C105.

5. Click virtual drives in the list under the heading Virtual Drives to include in the patrol read and click Add > or 
click Add All >> to include all of the virtual drives.

6. (Optional) Change the frequency at which the patrol read will run. 

The default frequency is weekly (168 hours), which is suitable for most configurations. The other options are 
hourly, daily, and monthly.

7. (Optional) Set Patrol Read to run at a specific time.

The default is for the patrol read to start when you click OK on this screen. To change the default so that the patrol 
read starts at a specific time, follow these steps (otherwise, skip this step and proceed to the next step):

a. Uncheck the box Perform Patrol Read when I click OK.
b. Select the month, year, day, and time to start patrol read.

NOTE  It is recommended that you leave the patrol read frequency and other patrol read settings at the 
default values to achieve the best system performance. If you decide to change the values, record the 
original default value here so you can restore them later, if necessary:
Patrol Read Frequency: ___________________
Continuous Patrolling: Enabled/Disabled
Patrol Read Task Rate: ___________________
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8. Click OK to enable your patrol read selections.

To start a patrol read without changing the patrol read properties, follow these steps:

1. Click a controller icon in the left panel of the ServeRAID C105 main menu screen.

2. Select Go To > Controller > Start Patrol Read in the menu bar.

3. When prompted, click Yes to confirm that you want to start a patrol read.

8.6.1 Patrol Read Task Rates

You have the option to change the patrol read task rate. The task rate determines the amount of system resources that 
are dedicated to a patrol read when it is running. It is recommended, however, that you leave the patrol read task rate 
at its default setting. 

If you raise the task rate above the default, foreground tasks will run more slowly and it might seem that the system is 
not responding. If you lower the task rate below the default, rebuilds and other background tasks might run very 
slowly and might not complete within a reasonable time. For more information, about the patrol read task rate, see 
Section 7.2, Changing Adjustable Task Rates.

8.7 Monitoring Virtual Drives

When MegaRAID Storage Manager is running, you can see the status of all virtual drives. If a virtual drive is operating 
normally, the icon looks like this: . If the virtual drive is running in Degraded mode (for example, if a drive has failed) 
a small yellow circle appears to the right of the icon: .

When the Logical tab is selected, the left panel of the MegaRAID Storage Manager main menu screen shows the drives 
used by each virtual drive. The same drive can be used by multiple virtual drives.

To display complete virtual drive information, click the Logical tab in the left panel, and click on a virtual drive icon in 
the left panel. The properties appear in the right panel. The following figure shows the Properties panel for a 
virtual drive.

NOTE  Patrol read does not report its progress while it is running. The patrol read status is reported in the 
event log only.
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Figure 61  Virtual Drive Properties

The RAID level, stripe size, and access policy of the virtual disk are set when the virtual drive is configured.

If the drives in the virtual drive are in an enclosure, you can identify them by making their LEDs blink. To do this, follow 
these steps:

1. Click the virtual drive icon in the left panel.

2. Click Go To > Virtual Drive > Start Locating Virtual Drive or right-click a virtual drive and select Start Locating 
Virtual Drive from the menu.

The LEDs on the drives in the virtual drive start blinking (except for hotspare drives).

3. To stop the LEDs from blinking, click Go To > Virtual Drive > Stop Locating Virtual Drive.
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8.8 Monitoring Rebuilds and Other Processes

MegaRAID Storage Manager allows you to monitor the progress of rebuilds and other lengthy processes in the Group 
Show Progress window.

Follow these steps to monitor the progress of these operations.

1. Select Manage > Show Progress on the menu bar to open this window, as shown in the following figure. 

Figure 62  Group Show Progress Menu

The Group Show Progress window appears, as shown in the following figure.



- 99 -

ServeRAID C105 User’s Guide
May 2013

Chapter 8: Monitoring System Events and Storage Devices
Monitoring Rebuilds and Other Processes

Figure 63  Group Show Progress Window

Operations on virtual disks appear in the left panel of the Group Show Progress window, and operations on 
physical drives appear in the right panel. The following operations appear in this window:

— Background or foreground initialization of a virtual disk
— Consistency check (see Section 9.2, Running a Consistency Check)
— Modify drive group
— Rebuild (see Section 9.3, Rebuilding a Drive)

2. (Optional) To abort an ongoing process, click the Abort button next to the status indicator.

3. (Optional) Click Abort All to abort all ongoing processes. 

4. Click Close to close the window.
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Chapter 9: Maintaining and Managing Storage Configurations

This section explains how to use MegaRAID Storage Manager to maintain and manage storage configurations. 

9.1 Initializing a Virtual Drive

To initialize a virtual drive after completing the configuration process, follow these steps:

1. Select the Logical tab in the left panel of the MegaRAID Storage Manager main menu screen, and click the icon of 
the virtual drive that you want to initialize.

2. Select Go To > Virtual Drive > Start Initialization. 

The Initialize dialog box appears.

3. Select the virtual disk(s) to initialize.

4. Select the Fast Initialization check box if you want to use this option. 

If you leave the box unchecked, MegaRAID Storage Manager runs a Full Initialization on the virtual disk. (For more 
information, see Section 7.1.1, Selecting Virtual Drive Settings.)

5. Click Start to begin the initialization.

You can monitor the progress of the initialization. See Section 8.8, Monitoring Rebuilds and Other Processes, for 
more information.

9.1.1 Running a Group Initialization

Initialization prepares the storage medium for use. You can run an initialization on multiple drives at one time. 

Follow these steps to run a group initialization.

1. Click Manage > Initialize.

The Group Initialization appears, as shown in the following figure.

CAUTION  Initialization erases all data on the virtual drive. Make sure you back up any data you want to 
keep before you initialize. Make sure the operating system is not installed on the virtual drive you are 
initializing.
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Figure 64  Group Initialization Dialog Box

2. Check the virtual drives to run the initialization on or click Select All to select all of the virtual drives.

3. Click Start.

You can monitor the progress of the group initialization. See Section 8.8, Monitoring Rebuilds and Other 
Processes, for more information.

9.2 Running a Consistency Check

The Consistency Check operation verifies correctness of the data in virtual drives that use RAID levels 1 and 10 (RAID 0 
does not provide data redundancy). For example, in a system with parity, checking consistency means computing the 
data on one drive and comparing the results to the contents of the parity drive. 

You should run a consistency check on fault-tolerant virtual drives periodically. You must run the consistency check if 
you suspect that the virtual drive data might be corrupted. Be sure to back up the data before running a consistency 
check if you think the data might be corrupted.

To run a consistency check, first set the consistency check properties and then schedule the consistency check. This 
section explains how to set the properties, schedule the check, and run the consistency check.
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9.2.1 Running a Group Consistency Check

You can run a consistency check on multiple drives at one time. Follow these steps to run a group consistency check.

1. Click Manage > Check Consistency.

The Group Consistency Check appears, as shown in the following figure.

Figure 65  Group Consistency Check Dialog Box

2. Check the virtual drives to run the consistency check on or click Select All to select all of the virtual drives.

3. Click Start.

You can monitor the progress of the group consistency check. See Section 8.8, Monitoring Rebuilds and Other 
Processes, for more information.

9.2.2 Scanning for New Drives

You can use the Scan for Foreign Configuration option to find drives with foreign configurations. A foreign 
configuration is a RAID configuration that already exists on a replacement set of drives that you install in a computer 
system. In addition, if one or more drives are removed from a configuration, by a cable pull or drive removal, for 
example, the configuration on those drives is considered a foreign configuration by the RAID controller. Drives that 
are foreign are listed on the physical drives list with a special symbol in ServeRAID C100 and ServeRAID C105. 

The utility allows you to import the existing configuration to the RAID controller or clear the configuration so you can 
create a new configuration using these drives. You can preview the foreign configuration before you decide whether 
to import it.
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ServeRAID C100 and ServeRAID C105 normally detect newly installed drives and display icons for them in the main 
menu screen. If for some reason, ServeRAID C100 and ServeRAID C105 do not detect a new drive (or drives), you can 
use the Scan for Foreign Configuration command to find it. 

Follow these steps to scan for a foreign configuration:

1. Select a controller icon in the left panel of the main menu screen.

2. Select Go To > Controller > Scan for Foreign Configuration.

If ServeRAID C105 detects any new drives, it displays a list of them on the screen. If not, it notifies you that no 
foreign configuration is found.

3. Follow the instructions on the screen to complete the drive detection.

9.3 Rebuilding a Drive

If a single drive in a RAID 1 or RAID 10 virtual disk fails, the system is protected from data loss. The failed drive must be 
replaced, and the drive’s data must be rebuilt on a new drive to restore the system to fault tolerance. (You can choose 
to rebuild the data on the failed drive if the drive is still operational.) If hotspare disks are available, the failed drive is 
rebuilt automatically without any user intervention.

If a drive has failed, a red circle appears to the right of the disk drive icon: . A small yellow circle appears to the 
right of the icon of the virtual drive that uses this drive: . This icon indicates that the virtual drive is in a degraded 
state; the data is still safe, but data could be lost if another drive fails.

Follow these steps if you need to rebuild a physical drive:

1. Right-click the icon of the failed drive, and select Rebuild.

2. Click Yes when the warning message appears. 

If the drive is still good, a rebuild starts. You can monitor the progress of the rebuild in the Group Show Progress 
window by selecting Manage > Show Progress. 

If the drive cannot be rebuilt, an error message appears. Continue with the next step.

3. Shut down the system, disconnect the power cord, and open the computer case.

4. Replace the failed disk drive with a new drive of equal capacity.

5. Close the computer case, reconnect the power cord, and restart the computer.

6. Restart MegaRAID Storage Manager.

When the new drive spins up, the drive icon changes back to normal status, and the rebuild process begins 
automatically. You can monitor the progress of the rebuild in the Group Show Progress window by selecting 
Manage > Show Progress.

9.4 Making a Drive Offline or Missing

If a drive is currently part of a redundant configuration and you want to use it in another configuration, you can use 
ServeRAID C100 and ServeRAID C105 commands to remove the drive from the first configuration and change the 
drive state to Unconfigured Good. 

CAUTION  After you perform this procedure, all data on that drive is lost.
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To remove the drive from the configuration without harming the data on the virtual drive, follow these steps:

1. On the main menu screen, click Go To > Physical Drive > Make Drive (O)ffline. 

The drive status changes to Offline.

2. Click Go To > Physical Drive > (M)ark Drive as Missing.

The drive status changes to Unconfigured Good. 

3. If necessary, create a hotspare drive for the virtual drive from which you have removed the drive. (See Section 7.2, 
Changing Adjustable Task Rates.)

When a hotspare is available, the data on the virtual drive will be rebuilt. You can now use the removed drive for 
another configuration.

CAUTION  After you perform this step, the data on this drive is no longer valid.

CAUTION  If ServeRAID C100 and ServeRAID C105 detect that a drive in a virtual drive has failed, they 
make the drive offline. If this happens, you must remove the drive and replace it. You cannot make the 
drive usable for another configuration by using the Mark physical disk as missing and Rescan 
commands.
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Appendix A: ServeRAID C100 and ServeRAID C105 MegaRAID 
Storage Manager Events and Messages

This appendix lists the MegaRAID Storage Manager events and their related messages that can appear in the 
event log.

MegaRAID Storage Manager monitors the activity and performance of all controllers in the workstation and the 
devices attached to them. When an event occurs, such as the start of an initialization, an event message appears in the 
log at the bottom of the MegaRAID Storage Manager main menu screen.

Each message that appears in the event log has an error level that indicates the severity of the event, as shown in 
Table 47.

Table 48 lists all of the MegaRAID Storage Manager event messages. The event message descriptions include 
placeholders for specific values that are determined when the event is generated. Some of the error messages are 
relevant only for hardware RAID.

NOTE  MegaRAID Storage Manager can be used to manage a wide range of ServeRAID controllers. Some of 
the events and messages listed in this appendix are not applicable to ServeRAID C100 and ServeRAID C105.

Table 47  Event Error Levels

Error Level Meaning

Information Informational message; no user action is necessary.

Warning Some component may be close to a failure point.

Caution A component has failed, but the system has not lost data.

Fatal A component has failed, and data loss has occurred or will occur.

Dead A catastrophic error has occurred, and the controller has died. This event is seen only after the controller has 
been restarted.

Table 48  Event Messages

Number
(Hex)

Number
(Decimal) Type Event Text

0x0000 0 Information Firmware initialization started (PCI ID %04x/%04x/%04x/%04x) 

0x0001 1 Information Firmware version %s 

0x0002 2 Fatal Unable to recover cache data from TBBU 

0x0003 3 Information Cache data recovered from TBBU successfully 

0x0004 4 Information Configuration cleared 

0x0005 5 Warning Cluster down; communication with peer lost 

0x0006 6 Information %s ownership changed from %02x to %02x 

0x0007 7 Information Alarm disabled by user 

0x0008 8 Information Alarm enabled by user 

0x0009 9 Information Background initialization rate changed to %d%% 

0x000a 10 Fatal Controller cache discarded due to memory/battery problems 

0x000b 11 Fatal Unable to recover cache data due to configuration mismatch 

0x000c 12 Information Cache data recovered successfully 
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0x000d 13 Fatal Controller cache discarded due to firmware version incompatibility 

0x000e 14 Information Consistency Check rate changed to %d%% 

0x000f 15 Dead Fatal firmware error: %s 

0x0010 16 Information Factory defaults restored 

0x0011 17 Information Flash downloaded image corrupt 

0x0012 18 Caution Flash erase error 

0x0013 19 Caution Flash timeout during erase 

0x0014 20 Caution Flash error 

0x0015 21 Information Flashing image: %s 

0x0016 22 Information Flash of new firmware image(s) complete 

0x0017 23 Caution Flash programming error 

0x0018 24 Caution Flash timeout during programming 

0x0019 25 Caution Flash chip type unknown 

0x001a 26 Caution Flash command set unknown 

0x001b 27 Caution Flash verify failure 

0x001c 28 Information Flush rate changed to %d seconds 

0x001d 29 Information Hibernate command received from host 

0x001e 30 Information Event log cleared 

0x001f 31 Information Event log wrapped 

0x0020 32 Dead Multi-bit ECC error: ECAR=%x, ELOG=%x, (%s)

0x0021 33 Warning Single-bit ECC error: ECAR=%x, ELOG=%x, (%s)

0x0022 34 Dead Not enough controller memory 

0x0023 35 Information Patrol Read complete 

0x0024 36 Information Patrol Read paused 

0x0025 37 Information Patrol Read Rate changed to %d%% 

0x0026 38 Information Patrol Read resumed 

0x0027 39 Information Patrol Read started 

0x0028 40 Information Rebuild rate changed to %d%% 

0x0029 41 Information Reconstruction rate changed to %d%% 

0x002a 42 Information Shutdown command received from host 

0x002b 43 Information Test event: %s

0x002c 44 Information Time established as %s; (%d seconds since power on) 

0x002d 45 Information User entered firmware debugger 

0x002e 46 Warning Background Initialization aborted on %s 

0x002f 47 Warning Background Initialization corrected medium error (%s at %lx

0x0030 48 Information Background Initialization completed on %s 

0x0031 49 Fatal Background Initialization corrected medium error (%s at %lx, %s at %lx) 

0x0032 50 Fatal Background Initialization detected uncorrectable double medium errors (%s at 
%lx on %s) 

Table 48  Event Messages

Number
(Hex)

Number
(Decimal) Type Event Text
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0x0033 51 Caution Background Initialization failed on %s 

0x0034 52 Progress Background Initialization progress on %s is %s 

0x0035 53 Information Background Initialization started on %s 

0x0036 54 Information Policy change on %s from %s to %s

0x0038 56 Warning Consistency Check aborted on %s 

0x0039 57 Warning Consistency Check corrected medium error (%s at %lx, %s at %lx)

0x003a 58 Information Consistency Check done on %s 

0x003b 59 Information Consistency Check done with corrections on %s, (corrections=%d)

0x003c 60 Fatal Consistency Check detected uncorrectable double medium errors (%s at %lx on 
%s) 

0x003d 61 Caution Consistency Check failed on %s 

0x003e 62 Fatal Consistency Check failed with uncorrectable data on %s 

0x003f 63 Warning Consistency Check found inconsistent parity on %s at strip %lx 

0x0040 64 Warning Consistency Check inconsistency logging disabled on %s (too many 
inconsistencies) 

0x0041 65 Progress Consistency Check progress on %s is %s 

0x0042 66 Information Consistency Check started on %s 

0x0043 67 Warning Initialization aborted on %s 

0x0044 68 Caution Initialization failed on %s 

0x0045 69 Progress Initialization progress on %s is %s 

0x0046 70 Information Fast initialization started on %s 

0x0047 71 Information Full initialization started on %s 

0x0048 72 Information Initialization complete on %s 

0x0049 73 Information Properties updated to %s (from %s) 

0x004a 74 Information Reconstruction complete on %s 

0x004b 75 Fatal Reconstruction of %s stopped due to unrecoverable errors 

0x004c 76 Fatal Reconstruct detected uncorrectable double medium errors (%s at %lx on %s at 
%lx) 

0x004d 77 Progress Reconstruction progress on %s is %s 

0x004e 78 Information Reconstruction resumed on %s 

0x004f 79 Fatal Reconstruction resume of %s failed due to configuration mismatch 

0x0050 80 Information Reconstructing started on %s 

0x0051 81 Information State change on %s from %s to %s 

0x0052 82 Information Clear aborted on %s 

0x0053 83 Caution Clear failed on %s (Error %02x) 

0x0054 84 Progress Clear progress on %s is %s 

0x0055 85 Information Clear started on %s 

0x0056 86 Information Clear completed on %s 

0x0057 87 Warning Error on %s (Error %02x) 

0x0058 88 Information Format complete on %s 

Table 48  Event Messages
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0x0059 89 Information Format started on %s 

0x005a 90 Caution Hot Spare SMART polling failed on %s (Error %02x) 

0x005b 91 Information Inserted: %s 

0x005c 92 Warning %s is not supported 

0x005d 93 Warning Patrol Read corrected medium error on %s at %lx 

0x005e 94 Progress Patrol Read progress on %s is %s 

0x005f 95 Fatal Patrol Read found an uncorrectable medium error on %s at %lx 

0x0060 96 Caution Predictive failure: %s

0x0061 97 Fatal Puncturing bad block on %s at %lx 

0x0062 98 Information Rebuild aborted by user on %s 

0x0063 99 Information Rebuild complete on %s 

0x0064 100 Information Rebuild complete on %s 

0x0065 101 Caution Rebuild failed on %s due to source drive error 

0x0066 102 Caution Rebuild failed on %s due to target drive error 

0x0067 103 Progress Rebuild progress on %s is %s 

0x0068 104 Information Rebuild resumed on %s 

0x0069 105 Information Rebuild started on %s 

0x006a 106 Information Rebuild automatically started on %s 

0x006b 107 Caution Rebuild stopped on %s due to loss of cluster ownership 

0x006c 108 Fatal Reassign write operation failed on %s at %lx 

0x006d 109 Fatal Unrecoverable medium error during rebuild on %s at %lx 

0x006e 110 Information Corrected medium error during recovery on %s at %lx 

0x006f 111 Fatal Unrecoverable medium error during recovery on %s at %lx 

0x0070 112 Information Removed: %s 

0x0071 113 Warning Unexpected sense: %s, CDB%s, Sense: %s

0x0072 114 Information State change on %s from %s to %s 

0x0073 115 Information State change by user on %s from %s to %s 

0x0074 116 Warning Redundant path to %s broken 

0x0075 117 Information Redundant path to %s restored 

0x0076 118 Information Dedicated Hot Spare PD %s no longer useful due to deleted array

0x0077 119 Caution SAS topology error: Loop detected

0x0078 120 Caution SAS topology error: Unaddressable device

0x0079 121 Caution SAS topology error: Multiple ports to the same SAS address

0x007a 122 Caution SAS topology error: Expander error

0x007b 123 Caution SAS topology error: SMP timeout

0x007c 124 Caution SAS topology error: Out of route entries

0x007d 125 Caution SAS topology error: Index not found

0x007e 126 Caution SAS topology error: SMP function failed

0x007f 127 Caution SAS topology error: SMP CRC error
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0x0080 128 Caution SAS topology error: Multiple subtractive

0x0081 129 Caution SAS topology error: Table to table

0x0082 130 Caution SAS topology error: Multiple paths

0x0083 131 Fatal Unable to access device %s

0x0084 132 Information Dedicated Hot Spare created on %s (%s)

0x0085 133 Information Dedicated Hot Spare %s (%s) disabled

0x0086 134 Caution Dedicated Hot Spare %s no longer useful for all arrays

0x0087 135 Information Global Hot Spare created on %s (%s)

0x0088 136 Information Global Hot Spare %s (%s) disabled

0x0089 137 Caution Global Hot Spare %s does not cover all arrays

0x008a 138 Information Created %s

0x008b 139 Information Deleted %s

0x008c 140 Information Marking %s inconsistent due to active writes at shutdown

0x008d 141 Information Battery Present

0x008e 142 Warning Battery Not Present

0x008f 143 Information New Battery Detected

0x0090 144 Information Battery has been replaced

0x0091 145 Caution Battery temperature is high

0x0092 146 Warning Battery voltage low

0x0093 147 Information Battery started charging

0x0094 148 Information Battery is discharging

0x0095 149 Information Battery temperature is normal

0x0096 150 Fatal Battery needs replacement - SOH Bad

0x0097 151 Information Battery relearn started

0x0098 152 Information Battery relearn in progress

0x0099 153 Information Battery relearn completed

0x009a 154 Caution Battery relearn timed out 

0x009b 155 Information Battery relearn pending: Battery is under charge 

0x009c 156 Information Battery relearn postponed 

0x009d 157 Information Battery relearn will start in 4 days 

0x009e 158 Information Battery relearn will start in 2 day 

0x009f 159 Information Battery relearn will start in 1 day 

0x00a0 160 Information Battery relearn will start in 5 hours 

0x00a1 161 Information Battery removed 

0x00a2 162 Information Current capacity of the battery is below threshold 

0x00a3 163 Information Current capacity of the battery is above threshold 

0x00a4 164 Information Enclosure (SES) discovered on %s 

0x00a5 165 Information Enclosure (SAFTE) discovered on %s 

0x00a6 166 Caution Enclosure %s communication lost 
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0x00a7 167 Information Enclosure %s communication restored

0x00a8 168 Caution Enclosure %s fan %d failed

0x00a9 169 Information Enclosure %s fan %d inserted

0x00aa 170 Caution Enclosure %s fan %d removed

0x00ab 171 Caution Enclosure %s power supply %d failed

0x00ac 172 Information Enclosure %s power supply %d inserted

0x00ad 173 Caution Enclosure %s power supply %d removed

0x00ae 174 Caution Enclosure %s EMM %d failed 

0x00af 175 Information Enclosure %s EMM %d inserted 

0x00b0 176 Caution Enclosure %s EMM %d removed 

0x00b1 177 Warning Enclosure %s temperature sensor %d below warning threshold 

0x00b2 178 Caution Enclosure %s temperature sensor %d below error threshold 

0x00b3 179 Warning Enclosure %s temperature sensor %d above warning threshold 

0x00b4 180 Caution Enclosure %s temperature sensor %d above error threshold 

0x00b5 181 Caution Enclosure %s shutdown 

0x00b6 182 Warning Enclosure %s not supported; too many enclosures connected to port 

0x00b7 183 Caution Enclosure %s firmware mismatch (EMM %d)

0x00b8 184 Warning Enclosure %s sensor %d bad 

0x00b9 185 Caution Enclosure %s phy bad for slot %d

0x00ba 186 Caution Enclosure %s is unstable 

0x00bb 187 Caution Enclosure %s hardware error 

0x00bc 188 Caution Enclosure %s not responding 

0x00bd 189 Information SAS/SATA mixing not supported in enclosure; %s disabled 

0x00be 190 Information Enclosure (SES) hotplug on %s was detected, but is not supported 

0x00bf 191 Information Clustering enabled 

0x00c0 192 Information Clustering disabled 

0x00c1 193 Information PD too small to be used for auto-rebuild on %s 

0x00c2 194 Information BBU enabled; changing WT virtual disks to WB 

0x00c3 195 Warning BBU disabled; changing WB virtual disks to WT 

0x00c4 196 Warning Bad block table on %s is 80% full 

0x00c5 197 Fatal Bad block table on %s is full; unable to log block %lx 

0x00c6 198 Information Consistency Check Aborted Due to Ownership Loss on %s 

0x00c7 199 Information Background Initialization (BGI) Aborted Due to Ownership Loss on %s

0x00c8 200 Caution Battery/charger problems detected; SOH Bad

0x00c9 201 Warning Single-bit ECC error: ECAR=%x, ELOG=%x, (%s); warning threshold exceeded

0x00ca 202 Caution Single-bit ECC error: ECAR=%x, ELOG=%x, (%s); critical threshold exceeded

0x00cb 203 Caution Single-bit ECC error: ECAR=%x, ELOG=%x, (%s); further reporting disabled

0x00cc 204 Caution Enclosure %s Power supply %d switched off

0x00cd 205 Information Enclosure %s Power supply %d switched on
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0x00ce 206 Caution Enclosure %s Power supply %d cable removed

0x00cf 207 Information Enclosure %s Power supply %d cable inserted

0x00d0 208 Information Enclosure %s Fan %d returned to normal

 0x00d1 209 Information BBU Retention test was initiated on previous boot

0x00d2 210 Information BBU Retention test passed

0x00d3 211 Caution BBU Retention test failed!

0x00d4 212 Information NVRAM Retention test was initiated on previous boot

0x00d5 213 Information NVRAM Retention test passed

0x00d6 214 Caution NVRAM Retention test failed!

0x00d7 215 Information %s test completed %d passes successfully

0x00d8 216 Caution %s test FAILED on %d pass. Fail data: errorOffset=%x goodData=%x badData=%x

0x00d9 217 Information Self check diagnostics completed

0x00da 218 Information Foreign Configuration Detected

0x00db 219 Information Foreign Configuration Imported

0x00dc 220 Information Foreign Configuration Cleared

0x00dd 221 Warning NVRAM is corrupt; reinitializing

0x00de 222 Warning NVRAM mismatch occurred

0x00df 223 Warning SAS wide port %d lost link on PHY %d

0x00e0 224 Information SAS wide port %d restored link on PHY %d

0x00e1 225 Warning SAS port %d, PHY %d has exceeded the allowed error rate

0x00e2 226 Warning Bad block reassigned on %s at %lx to %lx

0x00e3 227 Information Controller Hot Plug detected

0x00e4 228 Warning Enclosure %s temperature sensor %d differential detected

0x00e5 229 Information Disk test cannot start. No qualifying disks found

0x00e6 230 Information Time duration provided by host is not sufficient for self check

0x00e7 231 Information Marked Missing for %s on array %d row %d

0x00e8 232 Information Replaced Missing as %s on array %d row %d

0x00e9 233 Information Enclosure %s Temperature %d returned to normal

0x00ea 234 Information Enclosure %s Firmware download in progress

0x00eb 235 Warning Enclosure %s Firmware download failed

0x00ec 236 Warning %s is not a certified drive

0x00ed 237 Information Dirty cache data discarded by user

0x00ee 238 Information PDs missing from configuration at boot

0x00ef 239 Information VDs missing drives and will go offline at boot: %s

0x00f0 240 Information VDs missing at boot: %s

0x00f1 241 Information Previous configuration completely missing at boot

0x00f2 242 Information Battery charge complete

0x00f3 243 Information Enclosure %s fan %d speed changed

0x00f4 244 Information Dedicated spare %s imported as global due to missing arrays
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0x00f5 245 Information %s rebuild not possible as SAS/SATA is not supported in an array

0x00f6 246 Information SEP %s has been rebooted as a part of enclosure firmware download. SEP will be 
unavailable until this process completes.

0x00f7 247 Information Inserted: %s Info: %s

0x00f8 248 Information Removed: %s Info: %s

0x00f9 249 Information %s is now OPTIMAL

0x00fa 250 Warning %s is now PARTIALLY DEGRADED

0x00fb 251 Caution %s is now DEGRADED

0x00fc 252 Fatal %s is now OFFLINE

0x00fd 253 Warning Battery requires reconditioning; please initiate a LEARN cycle

0x00fe 254 Warning VD %s disabled because RAID-5 is not supported by this RAID key

0x00ff 255 Warning VD %s disabled because RAID-6 is not supported by this controller

0x0100 256 Warning VD %s disabled because SAS drives are not supported by this RAID key

0x0101 257 Warning PD missing: %s

0x0102 258 Warning Puncturing of LBAs enabled

0x0103 259 Warning Puncturing of LBAs disabled

0x0104 260 Critical Enclosure %s EMM %d not installed

0x0105 261 Information Package version %s

0x0106 262 Warning Global affinity Hot Spare %s commissioned in a different enclosure

0x0107 263 Warning Foreign configuration table overflow

0x0108 264 Warning Partial foreign configuration imported, PDs not imported:%s

0x0109 265 Information Connector %s is active

0x010a 266 Information Board Revision %s

0x010b 267 Warning Command timeout on PD %s, CDB:%s

0x010c 268 Warning PD %s reset (Type %02x)

0x010d 269 Warning VD bad block table on %s is 80% full

0x010e 270 Fatal VD bad block table on %s is full; unable to log block %lx (on %s at %lx)

0x010f 271 Fatal Uncorrectable medium error logged for %s at %lx (on %s at %lx)

0x0110 272 Information VD medium error corrected on %s at %lx

0x0111 273 Warning Bad block table on PD %s is 100% full

0x0112 274 Warning VD bad block table on PD %s is 100% full

0x0113 275 Fatal Controller needs replacement, IOP is faulty

0x0114 276 Information CopyBack started on PD %s from PD %s

0x0115 277 Information CopyBack aborted on PD %s and src is PD %s

0x0116 278 Information CopyBack complete on PD %s from PD %s

0x0117 279 Progress CopyBack progress on PD %s is %s

0x0118 280 Information CopyBack resumed on PD %s from %s

0x0119 281 Information CopyBack automatically started on PD %s from %s

0x011a 282 Critical CopyBack failed on PD %s due to source %s error
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0x011b 283 Warning Early Power off warning was unsuccessful

0x011c 284 Information BBU FRU is %s

0x011d 285 Information %s FRU is %s

0x011e 286 Information Controller hardware revision ID %s

0x011f 287 Warning Foreign import shall result in a backward incompatible upgrade of configuration 
metadata

0x0120 288 Information Redundant path restored for PD %s

0x0121 289 Warning Redundant path broken for PD %s

0x0122 290 Information Redundant enclosure EMM %s inserted for EMM %s

0x0123 291 Information Redundant enclosure EMM %s removed for EMM %s

0x0124 292 Warning Patrol Read can't be started, as PDs are either not ONLINE, or are in a VD with an 
active process, or are in an excluded VD

0x0125 293 Information Copyback aborted by user on PD %s and src is PD %s

0x0126 294 Critical Copyback aborted on hot spare %s from %s, as hot spare needed for rebuild

0x0127 295 Warning Copyback aborted on PD %s from PD %s, as rebuild required in the array

0x0128 296 Fatal Controller cache discarded for missing or offline VD %s
When a VD with cached data goes offline or missing during runtime, the cache for 
the VD is discarded. Because the VD is offline, the cache cannot be saved.

0x0129 297 Information Copyback cannot be started as PD %s is too small for src PD %s

0x012a 298 Information Copyback cannot be started on PD %s from PD %s, as SAS/SATA is not supported 
in an array

0x012b 299 Information Microcode update started on PD %s

0x012c 300 Information Microcode update completed on PD %s

0x012d 301 Warning Microcode update timeout on PD %s

0x012e 302 Warning Microcode update failed on PD %s

0x012f 303 Information Controller properties changed

0x0130 304 Information Patrol Read properties changed

0x0131 305 Information CC Schedule properties changed

0x0132 306 Information Battery properties changed

0x0133 307 Warning Periodic Battery Relearn is pending. Please initiate manual learn cycle as 
Automatic learn is not enabled

0x0134 308 Information Drive security key created

0x0135 309 Information Drive security key backed up

0x0136 310 Information Drive security key from escrow, verified

0x0137 311 Information Drive security key changed

0x0138 312 Warning Drive security key, re-key operation failed

0x0139 313 Warning Drive security key is invalid

0x013a 314 Information Drive security key destroyed

0x013b 315 Warning Drive security key from escrow is invalid

0x013c 316 Information VD %s is now secured

0x013d 317 Warning VD %s is partially secured
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0x013e 318 Information PD %s security activated

0x013f 319 Information PD %s security disabled

0x0140 320 Information PD %s is reprovisioned

0x0141 321 Information PD %s security key changed

0x0142 322 Fatal Security subsystem problems detected for PD %s

0x0143 323 Fatal Controller cache pinned for missing or offline VD %s

0x0144 324 Fatal Controller cache pinned for missing or offline VDs: %s

0x0145 325 Information Controller cache discarded by user for VDs: %s

0x0146 326 Information Controller cache destaged for VD %s

0x0147 327 Warning Consistency Check started on an inconsistent VD %s

0x0148 328 Warning Drive security key failure, cannot access secured configuration

0x0149 329 Warning Drive security password from user is invalid

0x014a 330 Warning Detected error with the remote battery connector cable

0x014b 331 Information Power state change on PD %s from %s to %s

0x014c 332 Information Enclosure %s element (SES code 0x%x) status changed

0x014d 333 Information PD %s rebuild not possible as HDD/CacheCade software mix is not supported in a 
drive group

0x014e 334 Information Copyback cannot be started on PD %s from %s, as HDD/CacheCade software mix 
is not supported in a drive group

0x014f 335 Information VD bad block table on %s is cleared

0x0150 336 Caution SAS topology error: 0x%lx

0x0151 337 Information VD cluster of medium errors corrected for %s at %lx (on %s at %lx)

0x0152 338 Information Controller requests a host bus rescan

0x0153 339 Information Controller repurposed and factory defaults restored

0x0154 340 Information Drive security key binding updated

0x0155 341 Information Drive security is in EKM mode

0x0156 342 Warning Drive security failed to communicate with EKMS

0x0157 343 Information %s needs key to be %s %s

0x0158 344 Warning %s secure failed

0x0159 345 Critical Controller encountered a fatal error and was reset

0x015a 346 Information Snapshots enabled on %s (Repository %s)

0x015b 347 Information Snapshots disabled on %s (Repository %s) by the user

0x015c 348 Critical Snapshots disabled on %s (Repository %s), due to a fatal error

0x015d 349 Information Snapshot created on %s at %s

0x015e 350 Information Snapshot deleted on %s at %s

0x015f 351 Information View created at %s to a snapshot at %s for %s

0x0160 352 Information View at %s is deleted, to snapshot at %s for %s

0x0161 353 Information Snapshot rollback started on %s from snapshot at %s

0x0162 354 Fatal Snapshot rollback on %s internally aborted for snapshot at %s
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0x0163 355 Information Snapshot rollback on %s completed for snapshot at %s

0x0164 356 Information Snapshot rollback progress for snapshot at %s, on %s is %s

0x0165 357 Warning Snapshot space for %s in snapshot repository %s, is 80%% full

0x0166 358 Critical Snapshot space for %s in snapshot repository %s, is full

0x0167 359 Warning View at %s to snapshot at %s, is 80%% full on snapshot repository %s

0x0168 360 Critical View at %s to snapshot at %s, is full on snapshot repository %s

0x0169 361 Critical Snapshot repository lost for %s

0x016a 362 Warning Snaphot repository restored for %s

0x016b 363 Critical Snapshot encountered an unexpected internal error: 0x%lx

0x016c 364 Information Auto Snapshot enabled on %s (snapshot repository %s)

0x016d 365 Information Auto Snapshot disabled on %s (snapshot repository %s)

0x016e 366 Critical Configuration command could not be committed to disk, please retry

0x016f 367 Information COD on %s updated as it was stale

0x0170 368 Warning Power state change failed on %s (from %s to %s)

0x0171 369 Warning %s is not available

0x0172 370 Information %s is available

0x0173 371 Information %s is used for CacheCade with capacity 0x%lx logical blocks

0x0174 372 Information %s is using CacheCade %s

0x0175 373 Information %s is no longer using CacheCade %s

0x0176 374 Critical Snapshot deleted due to resource constraints for %s in snapshot repository %s

0x0177 375 Warning Auto Snapshot failed for %s in snapshot repository %s

0x0178 376 Warning Controller reset on-board expander

0x0179 377 Warning CacheCade (%s) capacity changed and is now 0x%lx logical blocks

0x017a 378 Warning Battery cannot initiate transparent learn cycles

0x017b 379 Information Premium feature %s key was applied for - %s

0x017c 380 Information Snapshot schedule properties changed on %s

0x017d 381 Information Snapshot scheduled action is due on %s

0x017e 382 Information Performance Metrics: collection command 0x%lx

0x017f 383 Information Premium feature %s key was transferred - %s

0x0180 384 Information Premium feature serial number %s

0x0181 385 Warning Premium feature serial number mismatched. Key-vault serial num - %s

0x0182 386 Warning Battery cannot support data retention for more than %d hours. Please replace the 
battery

0x0183 387 Information %s power policy changed to %s (from %s)

0x0184 388 Warning %s cannot transition to max power savings

0x0185 389 Information Host driver is loaded and operational

0x0186 390 Information %s mirror broken

0x0187 391 Information %s mirror joined

0x0188 392 Warning %s link %d failure in wide port
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0x0189 393 Information %s link %d restored in wide port

0x018a 394 Information Memory module FRU is %s

0x018b 395 Warning Cache-vault power pack is sub-optimal. Please replace the pack

0x018c 396 Warning Foreign configuration auto-import did not import any drives

0x018d 397 Warning Cache-vault microcode update required

0x018e 398 Warning CacheCade (%s) capacity exceeds maximum allowed size, extra capacity is not 
used

0x018f 399 Warning LD (%s) protection information lost

0x0190 400 Information Diagnostics passed for %s

0x0191 401 Critical Diagnostics failed for %s

0x0192 402 Information Server Power capability Diagnostic Test Started

0x0193 403 Information Drive Cache settings enabled during rebuild for %s

0x0194 404 Information Drive Cache settings restored after rebuild for %s

0x0195 405 Information Drive %s commissioned as Emergency spare

0x0196 406 Warning Reminder: Potential non-optimal configuration due to drive %s commissioned as 
emergency spare

0x0197 407 Information Consistency Check suspended on %s

0x0198 408 Information Consistency Check resumed on %s

0x0199 409 Information Background Initialization suspended on %s

0x019a 410 Information Background Initialization resumed on %

0x019b 411 Information Reconstruction suspended on %s

0x019c 412 Information Rebuild suspended on %

0x019d 413 Information Copyback suspended on %s

0x019e 414 Information Reminder: Consistency Check suspended on %

0x019f 415 Information Reminder: Background Initialization suspended on %s

0x01a0 416 Information Reminder: Reconstruction suspended on %s

0x01a1 417 Information Reminder: Rebuild suspended on %s

0x01a2 418 Information Reminder: Copyback suspended on %s

0x01a3 419 Information Reminder: Patrol Read suspended

0x01a4 420 Information Erase aborted on %s

0x01a5 421 Critical Erase failed on %s (Error %02x)

0x01a6 422 Progress Erase progress on %s is %s

0x01a7 423 Information Erase started on %s

0x01a8 424 Information Erase completed on %s

0x01a9 425 Information Erase aborted on %s

0x01aa 426 Critical Erase failed on %s

0x01ab 427 Progress Erase progress on %s is %s

0x01ac 428 Information Erase started on %s

0x01ad 429 Information Erase complete on %s
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0x01ae 430 Warning Potential leakage during erase on %s

0x01af 431 Warning Battery charging was suspended due to high battery temperature

0x01b0 432 Information NVCache firmware update was successful

0x01b1 433 Warning NVCache firmware update failed

0x01b2 434 Fatal %s access blocked as cached data in CacheCade is unavailable

0x01b3 435 Information CacheCade disassociate started on %s

0x01b4 436 Information CacheCade disassociate completed on %s

0x01b5 437 Critical CacheCade disassociate failed on %s

0x01b6 438 Progress CacheCade disassociate progress on %s is %s

0x01b7 439 Information CacheCade disassociate aborted by user on %s

0x01b8 440 Information Link speed changed on SAS port %d and PHY %d

0x01b9 441 Warning Advanced Software Options was deactivated for - %s

0x01ba 442 Information %s is now accessible

0x01bb 443 Information %s is using CacheCade

0x01bc 444 Information %s is no longer using CacheCade

0x01bd 445 Information Patrol Read aborted on %s
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Appendix B: MDRAID Migration

This appendix describes the process to migrate from ServeRAID to MDRAID. 

Perform the following steps to run MDRAID and check if the DDF created using ServeRAID is recognized on the 
Romley platform:

1. Set AHCI in AHCI/Compatibility/Enhanced mode (non LSI mode). 

2. Set SCU in LSI’s RAID mode. 

3. Install the OS on AHCI controller. 

4. Create RAID 0/RAID 1 or RAID 5 volumes using pre-boot applications. 

5. Boot into the OS using the nodmraid option, the native iSCI driver would claim the SCU controller and discover 
the drives. 

6. Use MDADM to import the VOLUMES created using ServeRAID’s pre-boot applications by performing the 
following steps:

a. fdisk -l (show all connected disk) 
b. mdadm --examine /dev/devicename (examine all connected hard disks) 
c. mdadm --examine --scan --config=mdadm.conf > /etc/mdadm.conf

(populate the mdadm.conf file) 
d. mdadm --assemble –scan (scan all the PD’s and create the mdraid volume) 
e. mdadm /proc/mdstat or mdadm --detail /dev/md126 

7. Create file system over the imported MDRAID volume and perform the I/O operations. 

Figure 66  Setup After Migration



- 119 -

ServeRAID C105 User’s Guide
May 2013

Appendix B: MDRAID Migration

Perform the following steps to run MDRAID and check if the DDF created using ServeRAID is recognized on the 
Denlow Platform:

1. Install the OS on AHCI controller in AHCI mode.

2. Halt the system and remove the OS PD.

3. Set AHCI in LSI RAID mode.

4. Create RAID 0/RAID 1 or RAID 5 volumes using pre-boot applications.

5. Reboot and set the AHCI in AHCI mode.

6. Connect the OS PD into any one of the available AHCI port. 

7. Boot into the OS with nodmraid option, the native AHCI driver would claim the AHCI controller and discover the 
drives. 

8. Use MDADM to import the VOLUMES created using LSI’s SWR pre-boot applications. Use the following steps – 

9. fdisk -l (this will shows all the connected disk) 

a. mdadm --examine /dev/devicename (examine all connected hard disks) 
b. mdadm --examine --scan --config=mdadm.conf > /etc/mdadm.conf

(populate the mdadm.conf file) 
c. mdadm --assemble –scan (scan all the PD’s and create the mdraid volume)
d. mdadm /proc/mdstat or mdadm --detail /dev/md126

10. Create file system over the imported MDRAID volume and perform the I/O operations. 
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